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In This Guide...

The Concepts Guide presents “The Big Picture” behind the
Agilent TOF and Q-TOF LC/MS system to help you analyze
samples on your Agilent time-of-flight or quadrupole
time-of-flight mass spectrometer system. This guide helps you
understand how the hardware and software work together.

1 Overview

Learn how the Agilent 6200 Series TOF and 6500 Series Q-TOF
LC/MS system helps you do your job and how the hardware and
software work.

2  Instrument Preparation

Learn the concepts you need to prepare the instrument for
sample acquisition.

3 Methods with Acquisition Parameters

Learn concepts to help you enter instrument control parameter
values and set up methods with acquisition parameters.

4 Data Acquisition

Learn concepts to help you enter information to run individual
samples or a worklist of samples, and to help you acquire data
and monitor runs.
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This chapter provides an overview of the Agilent 6200 Series
TOF LC/MS and Agilent 6500 Series Q-TOF LC/MS systems and
the system components and how they work together to help you
get your job done.
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1 Overview

How does the TOF and Q-TOF system help you do your joh?

ESI — Electrospray lonization

APCI — Atmospheric Pressure
Chemical lonization

APPI - Atmospheric Pressure

Photo lonization

HPLC-Chip/MS — High Performance
Liquid Chromatography on a Chip
MALDI — Matrix-Assisted Laser
Desorption lonization

MMI - Multimode lonization

You can set up an Agilent 6200 Series Time-of-Flight LC/MS
(TOF) system and the Agilent 6500 Series Quadrupole
Time-of-Flight LC/MS (Q-TOF) system in several configurations:

¢ For normal flow LC/MS with a binary pump, quaternary
pump, well-plate sampler (or autosampler or HTC/HTS
autosampler) and ESI or Dual ESI with Agilent Jet Stream
Thermal Gradient Technology - Agilent 6530 Quadrupole
Time-of-Flight, Agilent 6540 Quadrupole Time-of-Flight,
Agilent 6550 iFunnel Quadrupole Time-of-Flight, and Agilent
6230 Time-of-Flight.

¢ For normal flow LC/MS with a binary pump, quaternary
pump, well-plate sampler (or autosampler or HTC/HTS
autosampler) and ESI, Dual ESI, APCI, APPI, or MMI ion
sources.

¢ For microflow LC/MS with a capillary pump, micro well-plate
sampler and ESI, Dual ESI, APCI or MMI ion sources

¢ For nanoflow LC/MS with a nanopump, micro well-plate
sampler and HPLC-Chip/MS interface (used in place of
standard or dual nanospray source) to increase reliability
and boost performance with narrow peak dispersion and
lower dead volumes.

¢ Agilent 6200 Series TOF or 6500 Series Q-TOF LC/MS system
with an AP-MALDI or PDF-MALDI source

Each Agilent system has advantages for high throughput sample
screening with highly sensitive detection and accurate mass
assignment. Each uses the same Agilent 6200 Series TOF or 6500
Series Q-TOF LC/MS software to enable these advantages.

The Agilent Accurate-Mass 6530 Q-TOF, the Agilent UHD
Accurate-Mass 6540 Q-TOF LC/MS, and the Agilent 6550
iFunnel Q-TOF LC/MS systems are the only Q-TOF instruments
that can use the Agilent Jet Stream Technology. The Agilent
6230 TOF LC/MS system is the only TOF that can use the
Agilent Jet Stream Technology. This technology utilizes a
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Overview 1

super-heated sheath gas to collimate the nebulizer spray which
dramatically increases the number of ions that enter the mass
spectrometer.

Help for applications

You can use one or more of the Agilent 6200 Series TOF or 6500
Series Q-TOF LC/MS systems in the following application areas
(for example):

¢ Combinatorial chemistry target compound analysis

¢ Natural products screening

¢ Compound profiling (e.g., bioavailability, pK)

¢ Protein/peptide identification and characterization

* Metabolomics

¢ Biomarker discovery

e Impurity profiling

Paired with Agilent’s 1200 Series LCs, the 6500 Series Q-TOF

LC/MS delivers fast, sensitive, reproducible analyses of small
and large molecules.

¢ Reproducible mass accuracy
¢ Low picogram and femtomole limits of detection
¢ Fast MS/MS operation (for the Q-TOF)

Help for data acquisition

Please refer to this guide, the Agilent MassHunter Workstation
Software - Data Acquisition Familiarization Guide, the
Agilent MassHunter Workstation Software - Data Acquisition
Quick Start Guide or the online Help for the Data Acquisition
program and the online Help or the Report Designer User
Information DVD for the Report Designer Add-in. The Report
Designer Add-in allows you to customize the templates that are
used when you print a report.
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1 Overview

To learn how to get started with the
Agilent 6200 Series TOF and 6500
Series Q-TOF, see the Quick Start
Guide.

To learn more about how to use the
Agilent 6200 Series TOF and 6500

Series Q-TOF with real samples and
data, see the Familiarization Guide.

To learn how to perform individual
tasks with the TOF and Q-TOF
LC/MS, see the online Help. Press
F1 to access the online Help.

To learn more about an Agilent
1100 or 1200 LC module or 1260 or
1290 Infinity LC module, see the
Agilent 1100 LC, 1200 LC, 1260
Infinity LC or 1290 Infinity LC User
Guide for the module.

To learn more about the 6200
Series TOF or the 6500 Series
0-TOF, see the Maintenance Guide
for that instrument.

To learn how to install the system,
see the Installation Guide.

To help you use the Agilent 6200 Series TOF and the 6500 Series
Q-TOF LC/MS systems for these applications, the software lets
you perform the following tasks in a single window:

Prepare the instrument

Start and stop the instruments from the software.

Download settings to the Agilent 1200, 1260 Infinity or 1290
Infinity liquid chromatograph and the TOF and Q-TOF mass
spectrometer in real time to control the instrument.

See if the 6200 Series TOF and 6500 Series Q-TOF parameters
are within the limits to produce the specified mass accuracy
and resolution with a Checktune, Quicktune or Standard
tune report.

Optimize TOF and Q-TOF parameters automatically or
manually through Agilent tuning programs.

Monitor the actual conditions of the instrument.

View the Real-time Plot for chromatograms, spectra, and
instrument parameters (both DAD, TOF and Q-TOF) and
print a Real-time Plot report.

View the centroided line spectrum of a peak or the mass
range profile spectrum of a peak in real time.
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Overview 1

Set up data acquisition methods

¢ Enter and save parameter values for all LC modules and the
Agilent 6200 Series TOF and 6500 Series Q-TOF to a data
acquisition method.

¢ Enable reference mass correction and select reference
standard masses to correct the mass assignments during
a sample run.

¢ Select and label the total ion chromatograms or extracted ion
chromatograms that you want to appear in the real-time plot.

e Set up time segments for each run where parameters change
with the time segment or with the experiments within the
time segment.

¢ Print an acquisition method report.

Acquire data

¢ Enter sample information and pre- or post-analysis programs
(scripts) and run single samples interactively

A worklist is a list of a sequence of  * Enter and automatically run both individual samples and

samples that you enter and run sequences of samples in a worklist
automatically with the Data

Acquisition program. ¢ Set up pre- and post-analysis scripts to run between samples

in a worklist.

¢ Set up and run a worklist.

Help for data analysis

Agilent MassHunter Workstation Software - Qualitative Analysis

Qualitative Analysis is the primary program you use to work
with your TOF and Q-TOF data. You can use the Find
Compounds capability to confirm the presence of known
compounds with targeted MS/MS data, identify unknowns with
auto MS/MS data and do molecular feature extraction with MS
data. You can also search the data file for the presence of
specified formulas.
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Agilent also designed the Qualitative Analysis program to
present large amounts of data for review in one central location.
With the program you can perform these operations for any
type of mass spectrometer data that you open:

e Extract and display chromatograms.
¢ View and extract peak spectra.
¢ Subtract background.

¢ Integrate chromatograms.

You can also set up methods to automatically do the tasks in the
list, as well as others, when you open the data files. The
software also provides preconfigured templates for basic
reporting and enables the capability to create custom reports in
Microsoft Excel.

Please refer to the Agilent MassHunter Workstation Software -
Qualitative Analysis Familiarization Guide or the online Help
for the Qualitative Analysis software and the online Help or
Reporting Training DVD for the Report Designer Add-in. The
Report Designer Add-in allows you to customize the templates
that are used when you print a report.

You can also purchase the Agilent MassHunter BioConfirm
Program which allows you to view the digest list for the protein
sequences currently displayed. You can also compare a
reference data file to other data files using the Comparative
Amnalysis program which is available with BioConfirm. Please
refer to the Agilent MassHunter BioConfirm Quick Start Guide
or the Agilent MassHunter BioConfirm Familiarization Guide or
the online Help for the Qualitative Analysis program for more
information.

Agilent MassHunter Workstation Software - Quantitative
Analysis

Agilent also provides you with the opportunity to quantitate
your data. Agilent has designed the quantitative analysis
software to help quantitate very low amounts of material with
the following unique features:

¢ Provides a curve-fit assistant to test all fits and statistics on
curve quality
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¢ Integrates with an automated, parameter-free integrator that
uses a novel algorithm

¢ Presents a Batch-at-a-Glance results window to help you
review and operate on an entire batch of data at once

¢ Automatically detects and identifies outliers

Please refer to the Agilent MassHunter Workstation
Quantitative Analysis Software Familiarization Guide or the
online Help for the Quantitative Analysis software. You can
access the Familiarization Guide directly from the on

For the Report Designer Add-in, please refer to the online Help
or Reporting Training DVD. The Report Designer Add-in allows
you to customize the templates that are used when you print a
report.
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How do different ion sources work?

16

The Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS
systems operate with the following interchangeable atmospheric
pressure ionization (API) sources:

“Electrospray ionization (ESI) and Dual ESI” on page 17

“Dual Agilent Jet Stream Electrospray Ionization (Dual AJS
ESI)” on page 21

“Atmospheric pressure chemical ionization (APCI)” on
page 22

“Atmospheric pressure photoionization (APPI)” on page 24
“Multimode ionization (MMI)” on page 25
“HPLC-Chip” on page 27

The sources that are used are the B-type sources.
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Electrospray ionization (ESI) and Dual ESI

You control the spray chamber
parameters (nebulizer pressure,
drying gas flow and temperature,
and capillary voltage) when you set
up a method in the Method and
Run Control view, described in
Chapter 4.

Electrospray ionization relies in part on chemistry to generate
analyte ions in solution before the analyte reaches the mass
spectrometer. As shown in Figure 1, the LC eluent is sprayed
(nebulized) into a spray chamber at atmospheric pressure in the
presence of a strong electrostatic field and heated drying gas.
The electrostatic field occurs between the nebulizer, which is at
ground in the Agilent design, and the capillary, which is at high
voltage.

The spray occurs at right angles to the capillary. This design
reduces background noise from droplets, increases sensitivity,
and keeps the capillary cleaner for a longer period of time.

HPLC inlet ‘ For Dual ESI, a
second nebulizer is
utilized for the

. introduction of
nebulizer
E . reference mass
KH R ions. From an
ionization
perspective, the

mechanism is the
same.

capillary

solvent | &%

spray £
CICICICICICICICICICICICICKE)
A&

heated drying gas

Figure 1 Electrospray ion source

Electrospray ionization (ESI) consists of four steps:
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1 Formation of ions
2 Nebulization
3 Desolvation

4 Ton evaporation

Formation of ions

Ion formation in API-electrospray occurs through more than
one mechanism. If the chemistry of analyte, solvents, and
buffers is correct, ions are generated in solution before
nebulization. This results in high analyte ion concentration and
good API-electrospray sensitivity.

Preformed ions are not always required for ESI. Some
compounds that do not ionize in solution can still be analyzed.
The process of nebulization, desolvation, and ion evaporation
creates a strong electrical charge on the surface of the spray
droplets. This can induce ionization in analyte molecules at the
surface of the droplets.

Nebulization

Nebulization (aerosol generation) takes the sample solution
through these steps:

a Sample solution enters the spray chamber through a
grounded needle called a nebulizer.

b For high-flow electrospray, nebulizing gas enters the spray
chamber concentrically through a tube that surrounds the
needle.

¢ The combination of strong shear forces generated by the
nebulizing gas and the strong voltage (2-6 kV) in the spray
chamber draws out the sample solution and breaks it into
droplets.

d As the droplets disperse, ions of one polarity
preferentially migrate to the droplet surface due to
electrostatic forces.

e As a result, the sample is simultaneously charged and
dispersed into a fine spray of charged droplets, hence the
name electrospray.
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between charged species of the
same sign

Overview 1

Because the sample solution is not heated when the aerosol is
created, ESI does not thermally decompose most analytes.

Desolvation and ion evaporation

Before the ions can be mass analyzed, solvent must be removed
to yield a bare ion.

A counter-current of neutral, heated drying gas, typically
nitrogen, evaporates the solvent, decreasing the droplet
diameter and forcing the predominantly like surface-charges
closer together (see Figure 2).

( evaporation (R el [ Lt analyte ion ejected )
++ 4+ !
+ _ _ —_— B —>
- F L N
+ +h
== -+ +:|-_+
Figure 2 Desorption of ions from solution

When the force of the Coulomb repulsion equals that of the
surface tension of the droplet, the droplet explodes, producing
smaller charged droplets that are subject to further
evaporation. This process repeats itself, and droplets with a
high density of surface-charges are formed. When charge
density reaches approximately 108 v/ cm3, ion evaporation
occurs (direct ejection of bare ions from the droplet surface).
These ions are attracted to and pass through a capillary
sampling orifice into the ion optics and mass analyzer.

The importance of solution chemistry

The choice of solvents and buffers is a key to successful
ionization with electrospray. Solvents like methanol that have
lower heat capacity, surface tension, and dielectric constant,
promote nebulization and desolvation. For best results in
electrospray mode:

Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS System Concepts Guide 19
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The optional Agilent MassHunter
BioConfirm Software performs the
calculations to accomplish
deconvolution.

¢ Adjust solvent pH according to the polarity of ions desired
and the pH of the sample.

¢ To enhance ion desorption, use solvents that have low heats
of vaporization and low surface tensions.

* Select solvents that do not neutralize ions through gas-phase
reactions such as proton transfer or ion pair reactions.

¢ To reduce the buildup of salts in the ion source, select more
volatile buffers.

Multiple charging

Electrospray is especially useful for analyzing large
biomolecules such as proteins, peptides, and oligonucleotides,
but can also analyze smaller molecules like drugs and
environmental contaminants. Large molecules often acquire
more than one charge. Because of this multiple charging, you
can use electrospray to analyze molecules as large as 150,000 u
even though the mass range (or more accurately mass-to-charge
range) for a typical quadrupole LC/MS instrument is around
3000 m/z. For example:

100,000 w/ 10 2 = 1,000 m/z

When a large molecule acquires many charges, a mathematical
process called deconvolution is used to determine the actual
molecular weight of the analyte.
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Dual Agilent Jet Stream Electrospray lonization (Dual AJS
ESI)

With the Dual AJS ESI source, the nebulizing gas for the
reference spray can be switched for high flow or low flow
applications. The second sprayer improves the reference mass
stability over a wide range of LC conditions. Low flow
applications are typically less than 200 uL/minute. If the flow is
approximately 200 uL/minute, either low or high flow may be
appropriate.

> You connect the tubing here for low flow
applications.

Figure 3 Dual AJS ESI source plumbed for high flow application

Both the Dual AJS ESI and the Dual ESI source support two
nebulizers for different applications: the standard nebulizer
(G1958-60098) and the capillary (or microflow) LC/MS
nebulizer (G1946-60260). The main differences are:

The machined tip of the capillary LC/MS nebulizer has a
smaller exit orifice and internal taper.

The internal diameter (ID) of the internal needle for the
capillary LC/MS nebulizer is 50 uM versus 120 uM for the
“standard” nebulizer needle.

The recommended flow range (1 to 50 uL/minute) really is
capillary flow, whereas flows from 50 to 250 uL/minute are
typically described as microflow.
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Atmospheric pressure chemical ionization (APCI)

APCI is a gas-phase chemical ionization process. The APCI
technique passes LC eluent through a nebulizing needle, which
creates a fine spray. The spray is passed through a heated
ceramic tube, where the droplets are fully vaporized (Figure 4).

The resulting gas/vapor mixture is then passed over a corona
discharge needle, where the solvent vapor is ionized to create
reagent gas ions. These ions in turn ionize the sample molecules
via a chemical ionization process. The sample ions are then
introduced into the capillary.

HPLC inlet nebulizer (sprayer)

NS

vaporizer
(heater)

drying gas

e
\ capillary

O :-r..o...-..

‘5'0

corona
discharge
needle

Figure 4 Atmospheric pressure chemical ionization (APCI) source

APCI requires that the analyte be in the gas phase for ionization
to occur. To vaporize the solvent and analyte, the APCI source is
typically operated at vaporizer temperatures of 400 to 500°C.
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APCI is applicable across a wide range of molecular polarities.
It rarely results in multiple charging, so it is typically used for
molecules less than 1,500 u. Because of this molecular weight
limitation and use of high-temperature vaporization, APCI is
less well-suited than electrospray for analysis of large
biomolecules that may be thermally unstable. APCI is well
suited for ionization of the less polar compounds that are
typically analyzed by normal-phase chromatography.
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Atmospheric pressure photoionization (APPI)

With the APPI technique, LC eluent passes through a nebulizing
needle to create a fine spray. This spray is passed through a
heated ceramic tube, where the droplets are fully vaporized.
The resulting gas/vapor mixture passes through the photon
beam of a krypton lamp to ionize the sample molecules

(Figure 5). The sample ions are then introduced into the
capillary.

APPI and APCI are similar, with APPI substituting a lamp for
the corona needle for ionization. APPI often also uses an
additional solvent or mobile phase modifier, called a “dopant”,
to assist with the photoionization process.

APPI is applicable to many of the same compounds that are
typically analyzed by APCI. APPI has proven particularly
valuable for analysis of nonpolar compounds.

HPLC injet nebulizer (sprayer)

vaporizer
(heater)

drying gas

/
\ capillary

Figure 5 Atmospheric pressure photoionization (APPI) source
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Multimode ionization (MMI)

The multimode source is an ion source that can operate in three
different modes: APCI, ESI or simultaneous APCI/ESI. The
multimode source incorporates two electrically separated,
optimized zones: one for ESI and one for APCI. During
simultaneous APCI/ESI, ions from both ionization modes enter
the capillary and are analyzed simultaneously by the mass

spectrometer.
HPLC inlet nebulizer
- ESI zone
N thermal container
B L
corona # {_ —, ———capillary
discharge L
needle '
drying gas

Figure 6 Multimode source

ESI and APCI are essentially incompatible processes because
each needs its own conditions for aerosol drying and electrical
fields. However, it is possible to form ions simultaneously from
ESI and APCI if the two ionization regions are separated in
space.

Multimode ionization (MMI) is useful for screening of
unknowns, or whenever samples contain a mixture of
compounds where some respond by ESI and some respond by
APCI. In these cases, the multimode source obviates the need to
run the samples twice to accomplish a complete analysis.

Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS System Concepts Guide 25



1

26

Overview

Unlike the APCI and APPI sources where the temperature of the
vaporizer is monitored, in the multimode source the actual
vapor temperature is monitored. As a result, the vaporizer is
typically set to between 200 and 250°C.
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HPLC-Chip

Traditional nanospray mass spectrometry has proven its
potential as a cost-effective, sensitive and reproducible
technique for the identification of peptides at femtomole to
atomol levels. However, connecting nano capillaries, columns
and valves frequently is a tedious procedure and requires user
skills and routine. When handled incorrectly, nano flow
connections are prone to leakage which are difficult to detect
and result in poor system performance and extended downtime
of the complete system. Quartz nanospray needles are prone to
blockages and require frequent replacement.

With the invention of HPLC-Chip technology, Agilent is
significantly reducing the need for user interaction and making
nanospray a rugged state-of-the-art technology.

The cornerstone of chip technology is the HPLC-Chip, a
3-dimensional structure made of sandwiched polyimide films.
Grooves of specific dimensions are laser-ablated into a layer of
polyimide film. The lamination of a top and bottom layer then
forms channels of trapezoidal or triangular shape inside the
chip which can either be used as capillaries or, if filled with
packing material, as nanocolumns. One end of the chip tapers
off into a polyimide nanospray emitter.

UV Laser  CAD Drawing

1. Ablate i}
Biocompatible, 4. Trim
-
X-Y Sta
2. Clean &

. HV-ES| contact
DA 5. Metallize

3. Laminate Top film with holes

i

Finished HPLC-Chip

Bottom film with channels

Figure 7 HPLC-Chip making process
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1 Overview

How does the Agilent TOF and Q-TOF mass spectrometer work?

6200 Series TOF

6500 Series
Q-TOF

Figure 8 shows the complete Agilent 6520
Q-TOF LC/MS schematic, including AJS
ESl ion source, ion transfer optics, heam
shaping optics, ion pulser, flight tube, and
detector.

Figure 8

28

The Agilent TOF is an orthogonal acceleration time-of-flight
mass spectrometer (0a-TOF). The acceleration pulse applied to
send the ions down the flight tube is orthogonal to the direction
that ions are entering the mass analyzer. This geometry
minimizes the effect of the entrance velocity on the flight time,
leading to higher resolution.

The Agilent 6500 Series Q-TOF LC/MS is a liquid
chromatograph Q-TOF mass spectrometer that performs MS/MS
using a quadrupole, a hexapole (collision cell) and

a time-of-flight unit to produce spectra. The quadrupole selects
precursor ions that are fragmented in the collision cell into
product ions, which are then impelled to the detector, at an
angle perpendicular to the original path.

The Agilent 6500 Series Q-TOF LC/MS supports several
atmospheric pressure ionization (API) sources. A common
atmospheric sampling interface introduces ions from these
various sources into the mass spectrometer vacuum system.

Quad Mass Filter (Q1) Octopole 2

Jocomme \ sl | __| b} ——
7 |l —

Lens 1 and 2 Collision Cell DC Quad
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Turbo  Turbo Turbo

L
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1=

A

4

lon Pulser

=

Schematic of Agilent 6520 Q-TOF LC/MS
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Figure 9 shows the
complete Agilent 6530
Q-TOF schematic, with
major improvements
identified.

These improvements are
described below
(“Innovative
Enhancements in the 6530

Q-TOF” on page 35). llJ N
Quad Mass Filter (Q1) ctopole 2 il

\mﬁ(__{?{"i‘“""" A\ il || | —

TN sk | | —

3 \Lens1and2 Collision Cell DC Quad

1LJ0JL 1L

-
Rough .+ .. Turbo
Pump :Smgl's 3-stage Turbo Pump '

Figure 9 Schematic of Agilent 6530 Q-TOF LC/MS with major improvements circled
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1 Overview

Figure 10 shows the
complete Agilent
6538/6540 Q-TOF
schematic, with major
improvements identified.

These improvements are
described below
(“Innovative
Enhancements in the 6540
and 6538 Q-TOF” on

page 33).

The Agilent 6540 Q-TOF
supports the Agilent Jet
Stream Technology. The
Agilent 6538 does not.

lon Mirror

¢ 6538/6540

lll Quad Mass Filter {Q1) lon Beam Shaper =' - =
m ,M”‘e:\E‘b %15; 1]
_“W ‘I :...--- (¢ — - JUL @
“ | \_‘ —Ii lon Pulser
Lens 1and 2 Collision Cell | Detector
l:‘:un'?: E Single 3-stage Turbo Pump Tu:bo E Tn;bo

Figure 10  Schematic of Agilent 6540 UHD Accurate-Mass Q-TOF LC/MS with major improvements circled
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This figure shows the
complete Agilent 6550
iFunnel Q-TOF schematic,
with major improvements

identified. The Agilent 6550 iFunnel Q-TOF

These improvements are supports the Agilent Jet Stream ESI

described below and the Dual Agilent Jet Stream ESI.

(“Innovative R

Enhancements in the
Agilent 6550 iFunnel
Q-TOF”).

4~ Embedded
Processor

Quad Mass Filter (Q1) lon Beam Shaper

ocero \ il | —LE L S =
Tl | ‘”L E
= lon Pulser
Lens 1 and 2 Collision Cell Detector
Rough Rough S‘WO Sstage Turbo Pump Turbo 3 Turbo

Pump 1 Pump 2 1 " 2

Figure 11 Schematic of Agilent 6550 iFunnel Q-TOF LC/MS with major improvements circled

Innovative Enhancements in the Agilent 6550 iFunnel Q-TOF

Dual Agilent Jet Stream Electrospray

The Dual Agilent Jet Stream Electrospray source allows you to
modify it for high flow and low flow applications. See “Dual
Agilent Jet Stream Electrospray Ionization (Dual AJS ESI)” on
page 21 for more information.

iFunnel Technology

The iFunnel Technology encompasses two enhancements to the
Agilent 6550 iFunnel Q-TOF: the Agilent Jet Stream technology,
a hexabore capillary and the Dual Ion Funnel technology.
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Innovative Enhancements in the Agilent 6550 iFunnel Q-TOF

Figure 12  The iFunnel Technology

Ions are generated using an electrospray ion source where the
analyte is simultaneously ionized and desolvated from the
liquid matrix. The iFunnel includes the application of Agilent
Jet Stream Technology (first introduced with the 6530) which
improves sensitivity via thermal gradient focusing and
enhanced desolvation.

The next innovative enhancement is the use of a short hexabore
capillary. It has 6 capillary inlets and samples up to 10X more
ion rich gas from the source. It captures the majority of the gas
from the source region. See Figure 13. The hexabore capillary
transmits a high gas/ion volume into the ion optic system.

Figure 13  Hexabore capillary
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The Dual Ion Funnel (DIF) technology is the next enhancement.
The DIF technology removes the gas and neutral noise but
captures the ions. It also extends the turbo pump’s lifetime. The
Dual Ion Funnel technology can transmit ions efficiently at as
high a pressure as possible. The first ion funnel has a pressure
between 7 and 14 torr. The second ion funnel is a low pressure
ion funnel (1 to 3 torr). The ion funnel works by having the RF
voltage focus the ions to the center and having the DC voltage
accelerate the ions to the exit. See Figure 14.

Agilent Hexabore Dual Stage
Jet Stream  Capillary lon Funnel
Technology

Figure 14  The Dual lon Funnel technology

Embedded processor

Innovative Enhancements in the 6540 and 6538 Q-TOF

lon Beam Compression Technology

The first improvement is the Ion Beam Compression Technology
(IBC) which cools and focuses the ion beam. This technology
simultaneously maximizes ion transmission and reduces beam
divergence. Active Ion Beam Compression is achieved with
Agilent’s Axial Ion Acceleration Technology applied to a
tapered ion guide design.

Ion beam compression provides up to a 10-fold compression and
cooling which helps in creating a much denser and thinner ion
beam that passes through a narrower slit leading into the slicer
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Innovative Enhancements in the 6540 and 6538 Q-TOF

and pulser region. The narrowed, cooled and condensed beam
is a key factor in enabling the gain in mass resolution to 40,000
while maintaining excellent sensitivity.

Figure 15  lon Beam Compression Technology

Extended Flight Tube with Enhanced Mirror Technology (EMT)

The second improvement is that the flight tube for the
6538/6540 Q-TOF is now five feet long.

The 1 ppm/C Expansion Coefficient for the Inner Flight Tube
virtually eliminates calibration drift due to flight tube
elongation. The second order temporal focusing ion mirror uses
a high transmission Harp Grid for maximum sensitivity.

New Fast Bipolar Detector

The third innovative enhancement is the new Fast Bipolar
detector. The scintillator is ultra fast and highly efficient. Also,
the new ultra fast response PMT design continues the tradition
of high dynamic range and detector lifetime.
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Figure 16  Fast Bipolar Detector

Innovative Enhancements in the 6530 Q-TOF

Ions are generated using an electrospray ion source where the
analyte is simultaneously ionized and desolvated from the
liquid matrix. The first of three (3) innovative Agilent
enhancements is found in the application of Agilent Jet Stream
Technology (denoted as 1 in Figure 9) which improves
sensitivity via thermal gradient focusing and enhanced
desolvation. This technology is described in detail below
(“Agilent Jet Stream Thermal Gradient Technology” on

page 36).

The desolvated ions then enter the mass spectrometer via an
innovative resistive and highly inert capillary transfer tube
(denoted as 2 in Figure 9) that improves ion transmission and
allows virtually instantaneous polarity switching.

Further increase in ion transmission is obtained by
improvement of the pumping speed in vacuum stage 2, resulting
in better ion capture by the first octopole (denoted as 3 in
Figure 9). The ions next pass through the optics and into the
quadrupole analyzer. The quadrupole analyzer consists of four
parallel hyperbolic rods through which selected ions based on
their mass to charge ratio are filtered.
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The ions passing through the quadrupole analyzer are then
directed through the collision cell where they are fragmented.
The collision cell is actually a hexapole filled with nitrogen, the
same gas that is used as the drying gas. The collision cell design
has axial acceleration for high speed MS/MS analysis. Fragment
ions formed in the collision cell are then sent to the TOF to
enable a user to isolate and examine product ions with respect
to precursor ions.

Agilent Jet Stream Thermal Gradient Technology

This technology is supported on the Agilent 6530 Quadrupole
Time-of-Flight mass spectrometer, the Agilent 6540 UHD
Accurate-Mass Quadrupole Time-of-Flight mass spectrometer,
the Agilent 6550 iFunnel Quadrupole Time-of-Flight mass
spectrometer and the Agilent 6230 Accurate-Mass
Time-of-Flight mass spectrometer.

Agilent Jet Stream Technology enhances analyte desolvation by
collimating the nebulizer spray and creating a dramatically
“brighter signal.” The addition of a collinear, concentric,
super-heated nitrogen sheath gas (Figure 17) to the inlet
assembly significantly improves ion drying from the
electrospray plume and leads to increased mass spectrometer
signal to noise. The Agilent 6530 Q-TOF gets
attomole-to-low-femtomole sensitivity for superior trace level
analyses.
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| /\ Sample
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Nebulizing

Gas -- -

Electrospray
MNebulizer
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Sheath Gas

Heated Nitrogen
Drying Gas

Enhanced
Desolvation

Resistive Sampling
Capillary Inlet to
Mass Spectrometer

Figure 17  Agilent Jet Stream Electrospray lon Source

Agilent Jet Stream thermal gradient focusing consists of a
superheated nitrogen sheath gas that is introduced collinear
with and concentric to the pneumatically assisted electrospray.
Thermal energy from the superheated nitrogen sheath gas is
focused to the nebulizer spray producing the most efficient
desolvation and ion generation possible. The enhanced
desolvation results in more ions entering the sampling capillary
as shown in Figure 17 and concomitant improved signal to
noise. Parameters for the Agilent Jet Stream Technology are the
superheated nitrogen sheath gas temperature and flow rate,
and the nozzle voltage.

The capillary is a resistive capillary that improves ion
transmission and allows virtually instantaneous polarity
switching.
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Front-end ion optics

An octopole ion guide is a set of
small parallel metal rods with a

common open axis through which

38

the ions can pass.

For information on the various ion sources, see “How do
different ion sources work?” on page 16

After the API source forms ions, the Agilent 6200 Series TOF or
6500 Series Q-TOF LC/MS system performs the following
operations, organized according to the stages of the ion path
and the vacuum stages of the TOF or Q-TOF. See Figure 8 on
page 28 for details.

lon enrichment (Vacuum stage 1)

Ions produced in an API source are electrostatically drawn
through a drying gas and then pneumatically conducted
through a heated sampling capillary into the first stage of the
vacuum system. The majority of drying gas and solvent vapor
are deflected by the skimmer and exhausted by a rough pump.
The ions that pass through the skimmer pass into the second
stage of the vacuum system.

lon transport 1 (Vacuum stage 2 and vacuum stage 3)

In this stage the ions are immediately focused by an octopole
ton guide. Radio frequency voltage applied to the parallel
octopole rods repel ions above a particular mass range toward
the center of the rod set. The ions pass through the octopole ion
guide because of the momentum obtained from being drawn
from atmospheric pressure through the sampling capillary.

In a Q-TOF and in the Agilent G6224 and G6230 TOF, the
octopole spans both the 2nd and the 3rd vacuum stages. Ions
exit the octopole and pass through two focussing lenses and an
RF lens.

In an Agilent 6220 TOF, the ions exit the first ion guide and pass
into the third stage of the vacuum system. In the third stage of
the vacuum, the ions are passed onto a second octopole
assembly (octopole 2) which then sends the ion on to the beam
shaping assembly.
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lon transport 2 (Vacuum stage 4 for 6220 TOF only)

In this fourth vacuum pumping stage, the pressure is now low
enough that there are few collisions of the ions with gas
molecules.

The following sections are only part of the Q-TOF LC/MS instrument. The
next section in the TOF instrument is the Beam shaping (Vacuum stage 4
for both 6220 TOF and Q-TOF) on page 40.

lon selection (Vacuum stage 4 for Q-TOF only)

Lens 2RF The phase of lens 2 RF is matched to that of the subsequent
quadrupole resulting in a significantly increased sensitivity.

Quad mass The quadrupoles consist of hyperbolic rods that optimize ion
filters transmission and spectral resolution. There tends to be more
ion loss with circular rods.

Pre-filter The end section of the quadrupole also consists of short
hyperbolic rods, but their RF voltages are only high enough to
guide ions into the collision cell.

lon fragmentation 2 (Vacuum stage 4 for Q-TOF only)

Tons selected by the quadrupole are then passed to the collision
cell where they are fragmented.

The axial acceleration collision cell is a high pressure hexapole
assembly with its axial acceleration adjusted to maximize
sensitivity while eliminating crosstalk.

Crosstalk occurs when product ions from a previously selected
precursor appear in a product ion spectrum of a subsequently

selected precursor because of slow clearance from the collision
cell. This creates a composite product ion spectrum which can

be difficult to interpret.

The components that contribute to this higher sensitivity and
faster response are
¢ Small diameter hexapole collision cell

¢ High frequency hexapole collision cell
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¢ Linear axial acceleration
¢ High pressure collision cell

¢ High speed digital electronics

The collision cell contains nitrogen, the same gas that is used in
the ion source. The small diameter of the hexapole assembly
assists in capturing fragmented ions.

Why a hexapole? The geometry of a hexapole provides
advantages in two domains: ion focusing and ion transmission.

e The first advantage is in ion focusing where a quadrupole is
better than a hexapole, which is better than an octopole, that
is, quadrupole > hexapole > octopole.

¢ The second advantage involves ion transmission across
a wide mass range, or m/z bandwidth. In this case, the
octopole is better than the hexapole, which is better than the
quadrupole.

The hexapole is chosen because, overall, it is the best for both
ion focusing and ion transmission.

Collision cell design The collision cell hexapole consists of six
resistively coated rods used to generate a potential difference
across the length of the collision cell.

A potential difference is always present. This ensures that the
precursor ions coming from the quadrupole or fragment ions
generated in the collision cell are transmitted and not allowed
to drift around at random.

Sweeping out the ions in this manner avoids the issue of
crosstalk where residual product ions from a previous
experiment can interfere with the product ion spectrum of

a subsequent experiment. A collision energy voltage is applied
over the accelerating linear voltage to generate fragments or
product ions.

Beam shaping (Vacuum stage 4 for both 6220 TOF and Q-TOF)

In the Agilent 6538 and 6540 UDH Accurate-Mass Q-TOF, ions
enter the ion beam compression technology. Ion beam
compression provides up to a 10-fold compression and cooling
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which helps in creating a much denser and thinner ion beam
that passes through a narrower slit leading into the slicer and
pulser region.

In the TOF, ions enter a second octopole ion guide of similar
design to the first octopole but with a lower direct current
potential. This second octopole ion guide accelerates the ions
and prepares them for beam shaping. For TOF, the fourth
vacuum stage contains Octopole 2 and the beginning of the
slicer assembly.

To facilitate beam shaping, lenses focus the ions so that as they
pass through the 4th vacuum stage they will enter the
time-of-flight analyzer as a parallel beam. The more parallel the
ion beam, the higher the resolution in the resulting mass
spectrum. After the ions have been shaped into a parallel beam,
they pass through a slit opening into the fifth and last vacuum
stage where the time-of-flight analysis takes place.

Flight tube/Mass Analyzer (Vacuum stage 4 for 6224/6230 TOF)
(Vacuum stage 5 for 6220 TOF and 6500 Series Q-TOF)

lon pulser The nearly parallel beam of ions passes into the time-of-flight
ion pulser. The ion pulser is a stack of plates, each one (except
the back plate) with a center hole. The ions pass into this stack
from the side just between the back plate and the first plate
with its center hole. To start the flight of the ions to the
detector, a high voltage (HV) pulse is applied to the back plate.
The applied pulse accelerates the ions through the stack of
pulser plates, acting as a rapid-fire ion gun.

Flighttube The ions leave the ion pulser and travel through the flight tube,
which is about one meter in length (see Figure 8). At the
opposite end of the flight tube is an ion “mirror”, which reflects
the ions that arrive near the end of the flight tube towards the
ion pulser. Because the ions entered the ion pulser with a
certain amount of forward momentum orthogonal to the flight
direction in the flight tube, they never return to the ion pulser,
but move to where the ion detector is mounted.

The ion mirror increases the resolving power of the instrument
by effectively doubling the flight distance (from one meter to
two meters) in the same space, and by performing a refocusing
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lon detection

operation so that ions having different initial velocities still
arrive simultaneously at the detector.

Because the calculation for the mass of each ion depends on its
flight time in the flight tube, the background gas pressure must
be very low. Any collision of an ion with residual gas slows the
ion on its path to the detector and affects the accuracy of the
mass calculation.

Figure 18 shows a schematic of the Agilent 6500 Series Q-TOF
LC/MS detector.
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Figure 18  Agilent 6200 Series TOF or 6500 Series Q-TOF detector, with
potentials shown for positive operation

At the surface of the ion detector is a microchannel plate
(MCP), a very thin plate containing a set of microscopic tubes
that pass from the front surface to the rear of the plate. When
an ion hits the front surface of the MCP, an electron escapes and
begins the process of electrical signal amplification. As freed
electrons collide with the walls of the microscopic tubes, an
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ever-increasing cascade of electrons travels to the rear of the
plate. Roughly 10 times more electrons exit the MCP than
incoming ions contact the surface.

These electrons are then focused onto a scintillator, which,
when struck by electrons, produces a flash of light. The light
from the scintillator is focused through two small lenses onto
a photomultiplier tube (PMT), which produces the electrical
signal read by the data system. The reason for producing an
optical signal from the MCP electrons is because the output of
the MCP is at roughly -6000 volts. The light produced by the
scintillator passes to the PMT, which has a signal output at
ground potential.
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Learn about the concepts that can help you prepare the
instrument for use.

This chapter assumes that the hardware and software are
installed, the instrument is configured and the performance
verified. If this has not been completed, see the Agilent 6200
Series Time-of-Flight LC/MS System Installation Guide or the
Agilent 6500 Series Quadrupole Time-of-Flight LC/MS System
Installation Guide.
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2 Instrument Preparation

LC preparation

To install, configure and start the To prepare the LC for sample runs, you usually do three tasks:
Le modules, see the Installation e Set up the LC modules for operation
Guide. ¢ Equilibrate or condition the column
e Monitor the plot baseline to assure pump and column
stability (See “Real-time displays” on page 63.)
See the Quick Start Guide and You can also view the system logbook for explanations of errors.

online Help for instructions on how  (See “System logbook” on page 68.)
to prepare the LC for a sample run.

LC module setup

You set up the LLC modules in the Instrument Status window
through the shortcut menus. The Instrument Status window is
also called the Dashboard. You can get help on any of the
devices by clicking the E button in the device pane.
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A3 Sampler 7-0 i Quat. Pump 7T-0 ,-’ ColumnComp. 7 — & Q-TOF T =
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\ e 2 é Port1->2 u _":]_,\~ aﬂ? Dual Sl
\S‘UH‘— 850 150 (@, 74 Q @@stama—dam:
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Control.. -
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Set Error Method Standby

Igentify Device
() Switch Valve

[\ Switch Thermostat Gn

Figure 19  Instrument Status window (or Dashboard) with shortcut menu for Column Comp.

Table 1 shows you the tasks that you may perform to set up the
LC modules and the menu items where you can do the tasks.
You can do most of these tasks using the shortcut menu.
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Table 1

Tasks to set up the LC modules

Instrument Preparation

If you have this module:

And you want to:

How:

Autosampler

Well-Plate Sampler
(WPS) or yWPS or
h-ALS or h-ALS-SL or
h-ALS-SL+

HTC/HTS

Binary, isocratic, and
guaternary pumps

CapPump

Nanopump

Change volumes for the installed syringe

Change volumes for the installed syringe

Select tray type and its position

Reset injector, Move Home, Needle Up or Down,

set the valve mainpass or the bypass

Update the plate assignments on the computer

Reset the injector

Turn the pump on, off or place in Standby

Set the date and time for automatic pump turnon

Set up to monitor solvent levels

Do same tasks as binary pump

Purge the pump

Set mixer and filter volumes

Enable a fast change in solvent composition

Do a flow sensor calibration

Do the same tasks as CapPump

Done in the Device Configuration user
interface

Done in the Device Configuration user
interface

Right-click the device panel and click Assign
Wellplates, Edit Wellplate Types

Right-click the device panel and click Reset
Sampler, Home Arm, Needle Up/Down,
Switch Valve to Bypass/Mainpass, Switch
Thermostat On, Wash Needle

Right-click the device panel and click Update
Plate Assignment

Right-click the device panel and click Reset
injector

Right-click the device panel and click Switch
Pump On/Off

Right-click the device panel and click Control

Right-click the device panel and click Bottle
Fillings

Same menu items as binary pump

Right-click the device panel and click Purge
On/Off

Right-click the device panel and click
Configuration

Right-click the device panel and click Start
Fast Composition Change

Right-click the device panel and click
Calibration

Same menu items as CapPump except for
Accuracy Calibration (flow sensor)
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Table 1

Tasks to set up the LC modules (continued)

If you have this module:

And you want to:

How:

Thermostat. Column
Compartment (TCC)

Diode Array Det. (DAD)

Turn the right or left controller on or off

Set the maximum controller temperatures

Enter information for the instrument columns

Turn UV or Visible lamp on

Set the date or time for automatic DAD turnon

Calibrate the DAD wavelength

Bring the baseline of the plot to zero

Show an intensity plot for the detector

Right-click the device panel and click
Configuration

Right-click the device panel and click Set
Temperature

Tools > Analytical Column Setup

Right-click the device panel and click UV
Lamp On; Vis Lamp On

Right-click the device panel and click Control

Right-click the device panel and click
Calibration

Right-click the device panel and click
Balance

Right-click the device panel and click
Intensity plot

Column equilibration and conditioning

You can set up to equilibrate or condition a column in different
ways with the Data Acquisition program.

Equilibration = Column equilibration eliminates any previously separated
compounds or impurities from the column after runs with
solvent of a single composition. To equilibrate a column before a
sample run, you pass the solvent that you intend to use for the

run through the column for a period of time.

Conditioning Column conditioning returns column characteristics to their

initial state after a gradient run. To condition a column before a
sample run, you pass the solvent of initial composition through
the column for a period of time.

Equilibration

You can equilibrate a column in one of three ways:
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¢ Interactively

You change the loaded method set points to the solvent
composition for the run, no volume for the injection, higher
than normal flow rates and no data storage. You can then
immediately apply these set points to the instrument and
interactively stop the run when the column is ready.

Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS System Concepts Guide 49



2 Instrument Preparation

For more information on worklists,
see Chapter 4, “Data Acquisition”.

50

With a method in an interactive run

You can save the method with the set points mentioned in the
above paragraph, and then do a run. The run uses the
method stop time. You can also use a post run time within a
sample method to equilibrate the column.

With a parameter in a worklist

You can set up a blank run in a worklist to use as your
equilibration run. Or you can set up an equilibration time for
any sample run, where the system waits the specified time
before injecting the sample. For both cases, the data is
stored.

Conditioning

You can condition a column in one of three ways:

With one of the first two procedures described in the
Equilibration paragraphs.

You enter pump conditions to bring the column to its initial
condition. You can also condition the column by setting a
post-run time in the method.

With a script in a worklist

The LC conditioning script, SCP_LCCondition, is part of the
Data Acquisition software. When you enter the script into the
worklist, you specify the method that you will use for the run.
If a TOF or Q-TOF is connected to the LC, you can also enter
a parameter that diverts the LC eluent to waste. With this
script, there is no injection and no data storage.
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TOF and Q-TOF preparation — calibration and tuning

See the Installation Guide for
instructions on how to install and
start the TOF or Q-TOF and perform
an initial autotune.

To learn how to tune and calibrate
the TOF or Q-TOF, see the Quick
Start Guide and online Help.

Tuning

See “Tuning choices” on page 53
to learn more about Agilent tuning
tools.

Calibration

After you start the instrument, you calibrate and tune the TOF
and Q-TOF. This section presents the background information to
help you understand calibration and tuning as they are
implemented in the Agilent TOF and Q-TOF LC/MS system.

The following distinctions show how tuning, optimization and
calibration are related in the Agilent MassHunter Workstation
Software.

Tuning is the process of adjusting both the quadrupole (for the
Q-TOF) and TOF parameters to achieve the following goals:

¢ Maximize signal intensity and maintain acceptable
resolution, or

¢ Maximize resolution and maintain acceptable signal intensity

The Agilent MassHunter Workstation software and its
documentation and online Help use the words “tuning” and
“optimization” interchangeably.

Agilent Autotune for the TOF and Q-TOF include Initial
Autotune, Checktune, Standard Tune, and Set Detector Gain for
TOF parameters. The tools for optimizing the TOF parameters
also include Quick TOF Tune. All of the TOF Autotune tools
perform both automatic calibration and tuning.

Agilent Autotune for the Q-TOF also includes Initial Autotune,
Checktune and Standard Tune for the quadrupole.

Calibration is the process of assigning accurate masses based
on the known masses of standard compounds, introduced either
prior to or while running the sample.

TOF mass calibration

Any time that you want to ensure mass accuracy of the
instrument, you do a calibration. You do mass calibrations by
passing a calibrant with known masses from the calibrant bottle
through the mass spectrometer.
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See Chapter 3, “Methods with
Acquisition Parameters,” starting
on page 71, to learn more about
mass correction using reference
standards.

Before you calibrate the instrument, you have to set the
instrument state to the proper instrument mode, mass range
and fast polarity switching mode. You set these values on the
Instrument State tab.

When you change the mass range or enable/disable fast polarity
switching on the Instrument State tab, the pulser frequency is
changed which results in the DEI pulser warming up or cooling
down. If the calibration is performed too soon, the DEI may still
be heating up or cooling down which can result in drift. See the
online Help for more information on the Instrument State tab.

At startup, you do a full mass calibration, either manually or
automatically. Automatic calibrations take place when you
select Initial TOF Autotune, TOF Tune or Quick TOF Tune. You
set up a manual calibration from the TOF Mass Calibration tab
in the Tune window (Figure 20).

ITHF Mase Caliblatiunj Autotune | Manual Tune | Disgnostics | Instrument State | Preferences |

Current Mass Cosfficients

a= [34533765566E-01 10 = [1.0152624434E+00 Calibrate Load
Default Save As

Peak detection window %T I
Murnber of spectia to average 1n

Mass Time Corverter

[ Masslw/al < Conveit-s T Timelused]

Show Extended

Figure 20 Standard TOF Mass Calibration tab of the Tune window

During sample analysis the system corrects the calibration with
the introduction of a standard containing reference masses, if
you enable the correction through the method.

The calibration equations used are proprietary.
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Tuning choices

You can see the tuning choices available to you on the Autotune
tab (Figure 21). Notice that you must tune the quadrupole
separately from the TOF for the Q-TOF instrument. Also,
starting with the B.02.01 release, not all of the tuning choices
are available with all sources.

With the ESI, Dual ESI, Dual AJS ESI, Multimode, APPI and
APCI ion sources, you can run Check Tune, Quick Tune, and
TOF Mass Calibration. You can only run Standard Tune, Set
Detector Gain and Initial Tune (TOF) if one of the supported
sources in Table 2 is installed. The Dual ESI source can run all
tuning choices with all instruments.

Table2  Supported Sources for All Autotune

Instrument Model Number Supported Sources for All Autotunes
6220 TOF ESI, Dual ESI

6230/6224 TOF Dual ESI, AJS ESI, Dual AJS ESI

6520 TOF Dual ESI

6530 Q-TOF Dual ESI, AJS ESI, Dual AJS ESI
6540/6538 Q-TOF Dual ESI, Dual AJS ESI

6550 Q-TOF Dual ESI, Dual AJS ESI

Also, the Instrument Mode affects which autotunes are
available to use. If the Instrument Mode is Extended Dynamic
Range (2 GHz) mode, then you can perform any of the
autotunes. If the Instrument Mode is not Extended Dynamic
Range mode, then you can only perform Quick Tune and Check
Tune. You set the Instrument Mode on the Instrument State
tab.

The Mass Range also affects which tunes are supported. You
can run all tunes if the Mass Range is Standard (3200 m/z). If
the Mass Range is Low (1700 m/z), you cannot run an Initial
Tune (TOF), an Initial Quad Tune, a Standard Quad Tune or a
Check Quad Tune. The software automatically switches the
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system into Standard (3200 m/z) mode. All the automatic
tuning choices calibrate the TOF using eight to ten masses,
except for the 1700 mass range, which calibrates using six
masses.

If Fast Polarity Switching is enabled on a Q-TOF instrument,
the Quadrupole autotune buttons are not available.

Figure 21

Autotune tab for a TOF instrument

TuneFle [aoTunstn  [Mass List (defaul]
) TOF Mass Calioration  Autetuns | Manual Tune | Diagnostics | istrument State | Preferences |
Ion Polarity T aw ool
@ Pasive (" Negstive o Patise Between Autotunes
e On | Mass /2] j o Ifer Calibration Salution Swapping] —
Dual ASESI = | 322048121 [¥ SetCDS taMane after Autotune Q
V| 622028360 Clear | TOF
Source Parameters V| 922.009798 [w Pasitive " Check Tune
Losd

q W | 1221.330837 " Buick Tune
Gas Temp | 225 225 C o s s1a7s - v Negative & Standerd Tune Start Autotuns
Dring Gas |7 13.0 I¢min v | 1521952313 &2 [ [Fast Polanty Switching " Set Detector Gain

:  Initil T
Nebulizer |20 5 psig | 2121333152 Al nialtune
VCap amn v [B05 w 71| 2421.613330
b V| 2771894828 | Mone
Chamber EEZR
Mozzle
Yoleee E Calision Eneray |0 Y
eal] 4
GacTene e 13T Calbrant Botle rae -
eall .
GosFlow |12 B0 Mmin |\ CRonte 6 Wasts O MS
[ Dissbls CDS [ Ensbles Calibh inAcn -

Figure 22
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See the Installation Guide for
instructions on how to do an Initial
Autotune
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Initial Autotune

When you select this option after installation or major service,
the system automatically adjusts all the tunable parameters to
optimize signal, resolution and mass axis calibration.

Table 2 on page 53 shows all of the sources that you can use to
run an Initial Tune. On all instrument models, you can perform
an Initial Tune with a Dual ESI source.

You set the Instrument Mode to Extended Dynamic Range in
the Instrument State tab before running an Initial Tune (TOF).

You only use Initial Tune (TOF) or Initial Quad Tune under
special circumstances because the process takes a long time to
complete.

* After you install the hardware and software

* After your TOF analyzer has been vented for maintenance or
service

¢ If you no longer have the previous tune files or parameters

¢ If Standard Autotune does not work

Instrument Time for Initial Tune (TOF) Time for Initial Quad Tune

Agilent 6538A, 6540A  up to 60 minutes for each  up to 60 minutes
and 6550A Q-TOF polarity

Other Q-TOF up to 30 minutes for each  up to 60 minutes
instruments polarity
TOF instruments up to 30 minutes foreach  N/A

polarity

During the Initial Tune process for the TOF, the system goes
through the following steps without your intervention.

a Resets any current tune parameters to original defaults
b Performs a coarse TOF mass axis calibration

¢ Adjusts all the tunable parameters automatically

d Performs a final TOF mass axis calibration

e Prints a tune report at the end of the Autotune process
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For Q-TOF instruments, after running an Initial Tune (TOF),
you need to adjust the Collision Cell Gas pressure. You can find
this procedure in the online Help.

During the Initial Quad Tune process, the system goes through
steps a, ¢, d and e.

Check Tune

The Check Tune report lets you know if the mass calibration
and optimization limits are met with a Pass or Fail.

You can perform a Check Tune with any instrument mode
selected and with any of the following sources installed:

e ESI

e AJS ESI (Agilent Jet Stream ESI)

e Dual ESI

¢ Dual AJS ESI (Dual Agilent Jet Stream ESI)

e MMI

e APPI

e« APCI

Agilent designed the instrument so that it does not need
frequent autotunes. Periodically, you may want to perform
Check Tune and Check Quad Tune to ensure that the

parameters are still optimized. You do not need to perform a
Check Quad Tune as often as a Check Tune (TOF).

Standard Tune

These tools perform many of the same optimization operations
as the Initial Tune tools but use the current settings as starting
values and does a limited set of ion optic ramps.

Table 2 on page 53 shows all of the sources that you can use to
run a Standard Tune. On all instrument models, you can
perform a Standard Tune with a Dual ESI source.
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The Standard Tune (TOF) and Quad Tune do subsets of the
Initial Tune (TOF) and Initial Quad Tune actions, and they use
the current tune parameters as starting points rather than
using the factory defaults.

Standard Tune (TOF) takes about 10 to 15 minutes, and Quad
Tune takes about 10 to 15 minutes to complete.

Quick Tune (TOF)

Quick Tune (TOF) automatically adjusts the most commonly
required subset of tunable parameters.

You can perform a Quick Tune with any instrument mode

selected and with any of the following sources installed:

* ESI

e AJS ESI (Agilent Jet Stream ESI)

* Dual ESI

¢ Dual AJS ESI (Dual Agilent Jet Stream ESI)

e MMI

* APPI

e APCI

Quick Tune takes 3 to 5 minutes because the software is

optimizing only the most significant parameters followed by a

calibration.

During Quick Tune the system goes through the following steps:
a Automatically opens the calibrant valve

b Adjusts the vertical Q (Vert Q) and bottom slit parameters
in the Beam Shaping Optics (optimizes transmission)

¢ Adjusts the middle mirror of the compound TOF ion
mirror (optimizes resolution)

d Does a mass axis calibration after the final adjustment

e Prints a tune report
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Set Detector Gain

Set Detector Gain adjusts the PMT voltage to obtain consistent
gain (amplification) of the ion current into electrical current. In
the Extended Dynamic Range (2 GHz) mode, it also adjusts the
preamp offset values and the time delay between gain channels.
This tool is a subset of Initial TOF Tune and Standard Tune.

Table 2 on page 53 shows all of the sources that you can use to
run a Set Detector Gain. On all instrument models, you can
perform a Set Detector Gain with a Dual ESI source.

You set the Instrument Mode to Extended Dynamic Range (2
GHz) in the Instrument State tab before running the Set
Detector Gain algorithm.

Manual Tune

See the online Help for detailed instructions to help you
manually tune the TOF or Q-TOF instrument. Only perform a
manual tune if the Autotune options produce a result that fails.

Order of using Autotune choices

Use the tuning options in the following order:

1 Check Tune for the TOF
If necessary, continue.

2 Quick Tune for the TOF (does not exist for the quadrupole)
If necessary, continue.

3 Standard Tune for the TOF
If necessary, continue.

4 Initial Tune for the TOF

Use the same order for tuning the quadrupole, if necessary.

If an initial Tune cannot complete, contact Agilent Support.
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Tune reports

At the end of every Check Tune, Quick Tune, or Standard
Tune, the system generates a printable Tune report in Excel.

The TOF and Quad tune reports let you know if optimization

Instrument Preparation

2

limits are met. For a TOF tune, the report also lets you know if
the mass calibration is satisfactory or not.

To print previous tune reports, you click the Tune Report

button in the Autotune tab.

TOF/Q-TOF TOF Tune Report

Tune Type:

M5 Model
Insrument ID
Serial#
Firmware Rev.
Data Path

Source Type

TOF Results

TOF Initial Tune

GEEBA Tune Date & Time 2005-04-14 12:51
Instrument 1 InsrumentState  Ba Dynamic Rangs (2 Gre)
US12345678

3.101

Dx\ Mass Hunter\ Tu ne\ QTOR Autotune.tun

ESi+ Agilent et Swasm  Polarity Fositive

< sy
3o PR
- ez ssee
boa- | RETF | B SaveE Eren J‘ i i
Y e sw un o P
Tz
TTT Spectrum Table
Delta
miz Actual Time Abund Res FWHM _Delta (m/z) (pprT)
116086255 116.086235 20,041 5140 5326 00234  -D.00002 .17
322048121 322.048311 32.43063 51622 7R 03 000015 0.5
6220289 62209164 4467299 106225 9350  0.0881 0000204 013
922005758 922008602 416624 128875 10522 0.0883 0001196 13
1221990637 122198938 622038 100241 11147 QIS 0001357 .03
1521971475 1521,971385  €9.3017 57358 11861 01302 -D.O000S 0,06
1821952313 1821950791  75.7282 66547 1329 01488 0001522 084
2121933152 212153297 BLE4414 91412 12506 01718 -0.00D1SZ .09
242191359 2421813357 8715468 56701 12778 04518 -D.DDDEIT 026
2721894829 721852461 92.33321 40616 13362 0206 -0.00236E 0,87
i Agilent Technologies Page 1of 2 Printed on: 4/22/2009 3t 10:34 PM
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Storage and retrieval of tune results and Instrument Mode

You can store the tuning parameters in a single file (*.tun) using
the Save or Save As buttons in the Instrument State tab. You
can also load tune files in the Instrument State tab (Figure 23).
The Mass Range, the Fast Polarity Switching option, the Slicer
Mode, and the Instrument Mode are also stored in the tune file.

TOF Mass Calbration | Autotune | Manual Tune | Disgnostics ~ Instument State ‘Praiaran:as}

Tune File

BT ane un save | Saves.| Load. |

Instrument Mode

Mass Rangs [Standard (3200 m7z) <]

Fast Polatty Switching  [Disabled <]

Slicer Mode: & High Resslution " High Sensivity
& High Resolulion (4 GHz, High Res Mode)

" 4 GHz [High Riesoluion Mode disabled)

" Ewtended Dynamic Range (2 GHz)
" Ewtended Mass Range (2 GHz)

Figure 23  Instrument State tab

Instrument Modes

You select from four different instrument modes.

High Resolution (4 GHz, High Res Mode) In this mode, the
system acquires data at a 4 GHz ADC rate while special
processing is performed in real time on the mass peaks detected
in each transient, weighting the apex data of the mass peaks
much more heavily than the shoulders. This leads to narrower
peaks in the summed transients (the mass spectra) and hence
improves resolution. The Mass Range can only be set to Low
(1700 m/z) or Standard (3200 m/z) if the Instrument Mode is set
to this value.

4 GHz (High Resolution Mode disabled) In this mode, no
processing is used at the transient level; however, the system
acquires data at a 4 GHz ADC rate. The Mass Range can only be
set to Low (1700 m/z) or Standard (3200 m/z) if the Instrument
Mode is set to this value.
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Extended Dynamic Range (2 GHz) In this mode, the system
acquires data at a 4 GHz ADC rate in dual channel mode. One
channel is recorded at a high detector gain while the other
channel operates at a low detector gain. The firmware stitches
the two channels together to produce a scan with a sampling
rate of 2 GHz, which results in a greatly increased dynamic
range. The Mass Range can only be set to Low (1700 m/z) or
Standard (3200 m/z) if the Instrument Mode is set to this value.

Extended Mass Range (2 GHz) In this mode, the system acquires
data at a 2 GHz ADC rate. The Mass Range can be set to Low
(1700 m/z), Standard (3200 m/z) or High (10,000). This is the
only mode that you can use with the highest mass range.
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Tune Set Point Modifications for Medium and Large Proteins

For medium and large proteins, the charge envelope may extend
beyond 3200 m/z. It is recommended that you acquire your
intact protein data in the Extended Mass Range (1 GHz) mode
on the Agilent 6200 Series TOF and Agilent 6520/6530 Q-TOF as
this allows the extended mass range needed for larger proteins.
If you are acquiring a protein and the charge states are “cut-off”
in one of the other modes, you can switch to this mode with the
extended mass range.

If you are acquiring medium and large protein data, it is also
recommended that the Quad AMU be raised to 300 amu instead
of using the value established by the Auto Tune algorithm. This
provides the Quad with enough power to transmit the high mass
ions through the quad. Failure to increase the Quad AMU will
result in a mass spectrum where the charge envelope appears to
be “cutoff” for the higher charge state ion clusters.

To adjust the Quad AMU, do the following steps:

1 Switch to the Tune Context.

2 Click the Manual Tune tab.

3 Click the Quad Tab.

4 For the Quad AMU, type 300 for the new value.
5

Save the tune value to save the new Quad AMU value. Then
exit the Tune Context.

Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS System Concepts Guide



Instrument Preparation 2

Real-time displays

Instrument Status Window

The Instrument Status window is also called the Dashboard.
You can see if a module is On, Off or in Standby by observing the
color of the bar in the title for each device pane. The title bar
also includes words describing the current state of each device.
The Instrument Status Bar appears at the bottom of the
Instrument Status window. You can see the overall state of the
Instrument in this Instrument Status Bar.

! Inatrumant 5 tahus x

00 & e B 00 & stnchy N OO0 & we N 00 & e I OO0 Sate (N
1 [ Inl A, qy D 252
- T i
- (5 ] 7 frcerion

Figure 24  Instrument Status window

Table3  Colors of Instrument States

Instrument State Color

On—-Preparing/Not ready Yellow

On—Ready Green

On—Waiting, Pre-run or Purple

post-run

On—~Running, Injecting Blue

Standby Light Gray—To see if the pump, TOF or Q-TOF is

in Standby mode or off, you can also look for
the check mark in the shortcut menu.

off Dark Gray

Error condition Red
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Real-time parameter values (Actuals)

What you can display

You select parameters and states to monitor for each
instrument module in the Actuals window.

Actuals Selection Dialog ==
Available Parameters Parameters to display

& HiP Sampler %
&l Binary Pump GQ-TOF: Net Ready Text Lang
Q-TOF: TOF Vac

(T ey Shee

+Fill A1 Sclvent Channel Name
- Fill A2

+Fill A2 Sclvent Channel Name
- Flow

+ Power

e

+ Ready State Description
 Ripple

+ Run State

+ Run Time

- Solvent Name A (A1)

- Solvent Name B (B1)

- Solvent Ratio A Clear Al
Solvent Ratio B
& Column Comp.
& DAD
= GTOF

 Capillary

- Chamber

+ Cantrol State

+Corana
Corena+1

oo o)

Figure 25  Actuals Selection dialog box

The parameters and states for each module listed below are
available for display.

See the online Help for
descriptions of each of these
parameters and states.

Table4  Actuals available for display

Module Parameter or State

All modules Run Time, Run State, Ready State, Ready Type, Not
Ready Text Long, Not Ready Text Short, Rawdata State,
Error State

ALS Vial, Sample, Volume, Needle, Command, Injectmode,

Tray Type A, Tray Type B, Overlap, Injectstatus, Temp,
Therm Power
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Table4  Actuals available for display

Module Parameter or State

WPS, yWPS, h-ALS,  The same as ALS except no Vial and addition of Drawn

h-ALS-SL and Volume, Sample Position and Needle Position
h-ALS-SL+
Binary Pump Solvent Ratio A, Solvent Ratio B, Flow, Pressure, Ripple,

Fill A,B, A1, B1, A2, B2, Power, Channel Name A, B,
Solvent Selection A, B

Capillary Pump Same as binary pump with no Fill A1, A2, B1, B2 and
with the addition of Solvent Ratio C, Solvent Ratio D, Fill
C. Fill D, Primary Flow, EMPV, Purge Status, Purge
Channel, Purge Time and Pump Op Mode

Nanopump Same as capillary pump with addition of FSAC State and
FSAC Step. FSAC stands for Flow Sensor Accuracy
Calibration. When you click the Accuracy Calibration
shortcut menu, these values show you the status of the
step in the test procedure.

Thermostatted Left Temp, Left Temp Set, Right Temp, Right Temp set,
Column Compartment Column Valve, Therm Power

35900E Current Vial

DAD G1315C, Sample WI A-H, Sample Bw A-H, Reference On A-H,
G1315D, G4212A, Reference WI A-H, Reference Bw A-H, UV Lamp, Vis
G4212B, G1365C and  Lamp

G1365D

DAD G1315A, Sample WI A-E, Sample Bw A-E, Reference On A-E,
G1315B, G1365A,and  Reference WI A-E, Reference Bw A-E, UV Lamp, Vis
G1365B Lamp

TOF or Q-TOF Rough Vacuum, High Vacuum, Gas Temp, Vaporizer

Temp, Drying Gas Flow, Nebulizer Pressure, Capillary
Current, Chamber Current, Corona Voltage, Charging
Voltage, Control State, Cal/Ref Mass, LC Stream
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Real-time Chromatogram Plot and Spectral Plot windows

What you can display

You can display plots in the Chromatogram Plot window and in
the Spectrum Plot window.

Table5 Chromatogram plots available for display

Module Plot type

Pumps Pressure vs. time

Thermostatted Column  Temperature Left, Temperature Right vs. time

Compartment

35900E ADC signal vs. time

DAD Signals A-H vs. time

TOF or Q-TOF Any chromatogram set up in the Chromatogram tab

of the Method Editor window:

» Any segment or scan of a total ion chromatogram
(TIC) or extracted ion chromatogram (EIC)
» Method set points and actual conditions

What you can do with the displays

Table6  What you can do with plots and spectra

Display type What you can do

Signal plots Change range of intensity or time, freeze and zoom the
plot

Pump parameters Change range of intensity or time, freeze and zoom the
plot

TOF or Q-TOF spectra  Autoscale the axes, freeze and zoom the plot; toggle
between a line spectrum and a profile spectrum; toggle
between a mass x-axis and a time x-axis, change to a
display of DAD spectra (from line spectra only)
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Profile vs. Centroid spectral displays

Centroid spectra for the TOF and Q-TOF display the abundance
vs. mass for the calculated centroid of the peak. Profile spectra
display the abundance vs. mass over the mass range of the peak.

Cpectim Plot x
Centroid [MS | + #MS1 Line Spectrum at 4 .48 min
mfz: 297 2421 297.2421
10000 Height: 11276 293.2008 295.2263
o 2891852 s 1293.2403 294 2159 296.2282
gmana BRI ez | B | R S O [ B RS i
288 289 280 291 282 283 284 285 286 287 208
v [~ m'z (amu}
Profile [MS [+ M31 Profile at 4.48 min
3iTE Area: 323809 409.1620 6451534
miz: 409.1620 ZeEN 518.3169
50000 FVWHM: 0.0233
25000 Height: 77640 I l 439.2302 46.1552
T Resplution: 17532 roadd fla, JI Jua Al l " L i
100 200 300 400 500 600 700 200 900 1000
v mz (amu)

Figure 26  Centroid and profile plots in the Spectrum Plot window

The default display is to plot abundance vs. mass, but you can
change the x-axis to time. To do this, right-click the Spectrum
Plot window and click Show Time from the shortcut menu. Click
Show Mass to return to the Abundance vs. Mass plot.
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System loghook

What you can view in the system loghook

The system logbook does not list The Logbook Viewer displays the dates and times when system
any changes to a method or events take place:
worklist.

* Run starts, stops and aborts

* Method loaded

¢ Tuning and calibration operations
* Unexpected software errors

¢ Device driver errors, warnings and alerts including leak
detection, vial not found, lamp burned out

¢ Device powered off or reconfigured
e Start up and shutdown

* Worklist events

e Method log files

When you open the Logbook Viewer, the software loads and
displays the most recent entries in the log file.

[ Loghook Viewer- D:\MassHuntenSysLogbaok.log E=x BRI

File Edit View Tools Help

MY

EventType EventSource |Category Description User il
System Statup  Shudy engine initialized admin

System Startup Worklist engine initialized, admin

System Startup Aecquisition engine initialized, admin -|

Status 8/11/2011 1253 PW

Figure 27  Logbook Viewer
The logbook also displays additional information about each
event. Since the display of individual columns can be turned on

and off, not all of these columns may be visible at any given
time.
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Table7  Columns available for display in the Logbhook Viewer

Column Name Description

Time Date and time of the event

Event Type Normal event or error

Event Source The module that produced the event (Worklist, Instr Mgr,

App Ul, Launcher, DA Mgr)

Category More information about the event (e.g. Startup,
Shutdown, Worklist Start, Worklist End, Run Started, Run
Stopped, Run Aborted, Method Loaded)

Description More information about the event

User Name of the user who started the acquisition engines
when the event occurred

What you can do with the system loghook

Move the cursor over an icon to The system deletes logbook entries that are older than the value

see the tooltips, which help you set in the System logbook purge dialog box. You can select a

perform the correct task. value from 1 day to 2 weeks. You click Tools > Purge Settings to
display this dialog box.

See the online Help for instructions

on how to work with the logbook. A copy of the logbook is automatically archived in the

\MassHunter\Log\Acq\Archive\Logbook folder. If you want to
view an archived logbook, click File > Open in the Logbook
Viewer program and select the .log that you want to view. You
can also save the logbook at any time by clicking File > Save
Logbook As.

Most of the tasks that you can do with the logbook help you
view the entries you need to see more easily.

Table 8  Tasks you can perform with the loghook

If you want to do this: Click this menu item or icon:
View an individual entry Edit > Find

View selected entries only Edit > Filter

Change column types and size View menu
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Table 8  Tasks you can perform with the loghook

If you want to do this: Click this menu item or icon:

View recent events View > Refresh

Archive entries File > Save or Shortcut menu > Export
Open, close, or save the logbook File menu

View method log files (method.log file ~ File > Open
in the Acq. or DA method folder)

Print the loghook Shortcut menu > Export or
File > Print

Change how long entries are saved in ~ Tools > Purge Settings
the logbook

Notification through the Taskbar

You can configure the system logbook to automatically display
messages from the taskbar. You can specify the type of messages
to display and how many messages to display at a time. By
default, this feature is disabled. To enable automatic logbook
notification, right-click on the Logbook icon in the Taskbar and
click Configure. After you have selected how many messages to
display and the type of messages, you then right-click the
logbook icon in the system tray and click Enable Notification.
Messages are still saved in the logbook whether or not you have
enabled automatic notification.
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See the online Help for instructions
on setting up methods and
parameter descriptions.
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Saving a method with data acquisition parameters 94

Method editing 96

Method reporting 97

You use this chapter to learn about the concepts that can help
you set up methods containing data acquisition parameters.
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Parameter entry

LC parameter entry

Most of the LC parameter entries are the same as those that you
can change with the Agilent 1200 LC control module and with
other Agilent software products, such as Agilent ChemStation.

Method Editor 3
(3 |2 = B | [B |[Defoult With_Dualals ESim <] = Apply | [ Reset
Propeties DA |'HiPSSrpler) HiP Sampler Pretrestment  Binary Pump  ColumnComp.  DAD  G-TOF

HIP Sampler (G1367D) mmm

Injection Mode * |[+| Advanced 2
Injection volume: 100 : |l Audliary -

© Standard injection Draw speed 1000 ©  plimin
" Injection with needle wash Eject speed 1000 . plimin H

n

Draw position, 00 . mm

Needle wash Equilibration time: 20 . sec

o Sample flush out factor. 50 : | times injection volume

Vial/wiell bottom sensing
Time: sec

Location High throughput

Repeat times
- |[+] Injection Cleaning -

orkList | Method Editor | Sample Run

Figure 28  LC parameter entry in the Method Editor window

TOF and Q-TOF parameter entry

Even though parameter entry is straightforward for the TOF
and Q-TOF, the background information in this section can help
you make the correct entries to produce the best results.

¢ Automatic parameter changes during a run

¢ General TOF and Q-TOF parameters

¢ Jon source parameters

¢ TOF and Q-TOF data acquisition parameters

* Setup for reference mass correction (recalibration)

e TOF and Q-TOF chromatogram setup
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Source | Acauisition | Ref Mass | Chromatogram
o Polsity (Seg] Dats Sterags [Sen)
& Posiive I Fast Polaily Switching " Mone  Centroid

" Megative * Buth " Profile

LC Stieam (Seq) Plot and Centioid Data Storags Threshald

= M MS MS/MS
LR #bs, teshold — [a00 absthreshald 5
Aply Now Rel threshald (%] [om Rel threshold [%) [om

I~ Do not wait for setpoints [e.9. temperature] to equilibrate

Figure 29  Q-TOF parameter entry in the Method Editor window

Automatic TOF and Q-TOF parameter changes during a run

You can set some TOF and Q-TOF method set points to be
different at different points in time during the run. The
different time points in the method are called time segments.
Within each time segment, you can have different sets of
parameters, called experiments.

Many parameters can be changed for different time segments.
Some parameters can be changed for different experiments in
the same time segment. For example, the gas temperature,
drying gas flow rate, and the nebulizer pressure must be the
same for all experiments in the same time segment, but
fragmentor and capillary voltages can be different for different
experiments.
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Properties DA HiPSampler  HiP Sampler Pretrestment  Bini
Jon Source lon Folaity- [~ Data Sterage| - LC Stieam

Dual&J5ES| | | | [ Pestive | Bath M5

Stop Time Time Segment and Experiment #

(& Mo Limit/As Pump Time [min) Expt
0 1
" Stop Time min
p 0 5

13

Cycle Time [3.1 ¢

Figure 30  Location for setup of Time Segments and Experiments

Per time segment set points are labeled with (Seg). Per
experiment set points are labeled with (Expt). All other set
points are per run. These set points can be found in these tabs.

¢ General Tab
¢ Source Tab

e Acquisition Tab

Acquisition tab

You can set up time segments for changing these parameters.

MS mode The MS mode spectral parameters can be set for
each time segment.

Auto MS/MS mode (Q-TOF only) The parameters on the
following tabs can be set for each time segment:

¢ Q-TOF Spectral Parameters Tab
Q-TOF Collision Energy Tab

¢ Q-TOF Precursor Selection I Tab
¢ Q-TOF Precursor Selection II Tab
¢ Q-TOF Preferred/Exclude Tab

Targeted MS/MS mode (Q-TOF only) The parameters on the
following tabs can be set for each time segment:

¢ Q-TOF Spectral Parameters Tab
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Automatic TOF and Q-TOF parameter changes during a run

* Q-TOF Collision Energy Tab
¢ Q-TOF Targeted List Tab

See “TOF and Q-TOF acquisition parameters” on page 79 for
a description of the TOF, Auto MS/MS and Targeted MS/MS

modes and their parameters.
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General TOF and Q-TOF parameters

You enter general TOF and Q-TOF parameters on the General
tab of either the TOF tab or the Q-TOF tab in the Method Editor

window.
[Genersl | Source | Acquisiton | RefMass | Chromatogram |
lon Folariy [Seg) Data Storage (Seg)
& Pasitive I Fast Polarity Switching  MNone " Centroid
£ Negative & Both £ Profie
LC Stream [Seg) Flot and Centraid Data Storage Threshald
& MS Ms MM
" Waste fbs thieshold [0 Bbe treshld  [5

Apply Now Rel threshold (%) [g.m Rl threshold (%) [go1

[~ Do not wait for setpaints [2.0. temperature] to equibrate

Figure 31  General tab of the Q-TOF Method Editor window

Profile vs. centroid spectra

You can save mass spectral data as whole peaks over the mass
range of the peak, or you can save only the data for the mass
whose intensity appears in the “middle” of the peak. To limit the
number of peaks whose centroid data are saved or appear in the
Spectrum Plot window (line spectra), you can set an absolute or
relative threshold for both MS and MS/MS data.

lon source parameters

See the online Help to view You can use several different sources with the Agilent TOF and
recommended parameter values Q-TOF LC/MS system:
for each ion source. ESI

e Dual ESI

* AJSESI

e Dual AJS ESI
e APCI
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APPI

AP-MALDI

PDF-MALDI

Orthogonal Nanospray
HPLC-Chip/MS interface
Dual Orthogonal Nanospray
Multimode (MMI)

GC-APCI

Each of the sources uses different parameters for controlling
the ion source. The default parameters are set for an
electrospray source. When you select a new ion source in the
Method Editor window, you see new parameter options and
boxes on the Source tab in the TOF tab or the Q-TOF tab.

General

£J5 ES| (Seg) M3 TOF (Expt]

]Aoqu'snmn} Ref Mass | Chromatogram |

GasTemp[330 T o T Fragmentor [175  V

Skimmer [5 v

Diying Gas [3 i [0 Vi OCT 1RF ¥pp [750 v
Mebulizer [35 psig [137 psi
Sheath Gas Temp [350 T p— T

Sheath Gas Flow [11 Vi [oo " Wmin ColisionEnergy [0 V

A1S ES| (Expt)
WCap | 2500 W Capilary [0.000 ud

Nozzle Yoltage (Expt) 1000 v
Chamber [0.00 uh

Figure 32  Source parameters in the Method Editor window
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Tips for using the AP-MALDI or PDF-MALDI source

For instructions on how to set up ¢ Tune the TOF or Q-TOF with an ESI source installed
and run samples with the .
AP-MALDI! and PDF-MALDI inlet

and ion source, see the online . .
Help. ¢ Set the proper settings in the AP-MALDI or PDF-MALDI

control software, and make sure that the desorption time is
not less than the MS TOF stop time.

Make sure the Run Type in the Sample Run window is set to
External Start.

For instructions on how to install

the AP-MALDI or PDF-MALDI ion Autotune for the AP-MALDI and PDF-MALDI source is not
source, see the Installation Guide. supported.

Before the AP-MALDI or the
PDF-MALDI is installed, in the
instrument configuration tool, the
LC must be removed from the
system configuration.

For more information on how to set
up the AP-MALDI to introduce
samples, refer to the Agilent
G1972A AP-MALDI LC/MSD Trap
SL System User Guide.
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TOF and Q-TOF acquisition parameters

The Acquisition tab in Figure 33 contains acquisition
parameters that you can change with time segments.

General | Source  Acquision IREIMassI Chromatogram

TOF Spectra

Mode: Mass Range

& M8 Min Flange [ton "
[5eql
Max Fiange 3000 i
Ao
MBS
Seg] Acuisition Bate/Time
o e Rate [T spechas
(Seg) Time [fogg  msfspectum

Tiansients/spectium 5904

Figure 33  Acquisition tab in the Method Editor window

The acquisition parameters you choose depend on what you are
trying to accomplish:

¢ If you want to pass all ions in a specified mass range through
the instrument with no fragmentation in the collision cell,
click MS (Seg) mode. This mode is automatically chosen for a
TOF instrument.

¢ If you don't know what you are looking for and must set up
boundary parameters for the precursor ion list, click Auto
MS/MS (Seg) mode.

¢ Ifyou know the compounds and hence the precursor ions you
are looking for, click Targeted MS/MS (Seg) mode.
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MS mode

In this mode the Q-TOF instrument behaves solely as a TOF
instrument with no quad isolation applied. You specify the mass
range and the acquisition rate and time to collect spectra.

General | Source  Acquisition Inav Mass | Chromatogram

TOF Spectra

Mode: Mass Range

Min Range [ me
Max Range ErT
Auto
© MEMS
5eg) Acquisition Rate/Time
Targeled
Mo Rate [T spectars

[Seg)

Time  [foo0 | me/spactum
Transientséspectum — [5a04

Figure 34  MS (Seg) Mode parameters in the Acquisition tab

Transients vs. mass range The mass spectrum resulting from

a single pulse of voltage applied to the ion pulser is called

a transtent. The recorded Mass Spectrum is, in reality, a result
of the application of multiple pulses to the ion pulser and

a summation of lower signal mass spectra, or transients.
(Figure 35)

For analyses that require one Mass Spectrum or scan per
second, the Agilent TOF and Q-TOF LC/MS software sums
10,000 transients before transferring the data from the
instrument back to the host computer to be written to disk. If
the target application involves high speed chromatography and
requires faster scanning, you can reduce the number of
transients per scan to increase the scans per second.

The length of transients is the time the system is allowed to
collect data for the transient in nanoseconds. On the Agilent
TOF and Q-TOF LC/MS, three mass range modes are available:

* Low (1,700 m/2)
e Standard (3,200 m/z)

¢ High (20,000 m/z) - The mass range of 20,000 m/z is available
for Accurate-Mass TOF and Q-TOF instruments.
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The transient length is set appropriately for each of these

modes.
Length of
AV v transients —
time of red flight
Q-TOF
Front End
A .- detector
=1/ |k

’iﬁJW * M1 = ion pulser

\ \

Figure 35  Length of transients is measured from the ion pulser to the
detector

Targeted MS/MS mode (Q-TOF only)

In this mode you specify the precursor ion that you want the
quadrupole to select and pass through to the collision cell for
fragmentation. The TOF portion of the instrument then passes
all the product ions through to the detector, and you select the
ion you want to look at in the spectrum produced by the TOF.
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General| Source  Asauistion | Ref Hass | Chromatogram |

Spectral Parameters } Colision Energy | Targeted List

MS M5 MS
Mode:
s Mass Range Mass Range
“ geq) Min Range 100 miz MinRange  [100 méz
e Max Riange 3000 miz MaxRange  [2000 miz
 MS/MS
(Seq) Acquisition Rate/Time Acquisition Rate/Time
targeted? Rate 1 spectrals Rate 1 spectrals
@ MS/MS
[Seq) Time 1000 s/ spectium Time 1000 me/spectium
Transients/spectium | 5304 Transients/spectium | 5304
Max Time betwesn
I W81 Speciia 5 6
Figure 36  The Spectral Parameters tab for Targeted MS/MS mode

Spectral Parameters These parameters are the same as those
for the TOF mode, but they are applied to both the quad (MS)
and the TOF components (MS/MS).

Collision Energy You can enter multiple fixed collision energies
(each collision energy is used), the slope and offset of a line, or
a table of collision energies.

General | Source  Acquisition b‘-\ef Mass | Chromatogram |

Spectral Parameters  Collsion Eneray hargmﬂ List

Mode " Use Fised Colision Ensraiss #
~ S @ s Table Colision Energy Table 10E

ool " Use Formula Wz 251 Z=2 | 2=3 23 ..

Auto > | 1 1 o o Bl
© M3/MS 2m o 1| of o [Py

il | o 1| 1| o s°°F

Targsted S
& MSMS RS

(Seg) < o2 f

0oL L
100
Figure 37  The Collision Energy tab for Targeted MS/MS mode

For general method development you set the slope and offset for
a curve whose collision energy the system selects to match the
precursor ion, m/z, on the curve.
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Targeted List For compounds for which you already know the
precursor ions, you can place the collision energy in the
targeted list for the precursor ion and vary its value to optimize
the abundance of the product ion.

General | Source  Acquisition Inav Mass | Chromatogram

Speciral Parameters | Collsion Eneroy  Targeted List

o Targeted List T able Default Valuss
ode:
o | Pres vz | 2 |Fet Time[ DetaRer [ | o | Colision| Acquiskion Time Charge stata 2]
M rin) | Time [miri Erergy | (ms/spec) :
Seg] | zaomoz] ] Medum(“4m/z) |18 |200
Auto M| amame| 0 Medim " miz] 12|20 Delta Ret. Tirme:
» s | 250208 1 0 Medum ("4 m/z) (10 |200 min
y || aoeos| 0 Medim [ miz) |22 |20
5 e 0. Width:
(Seg) Medim (2 m/

Figure 38 Targeted List tab for Targeted MS/MS mode

The collision energies specified here override the values
specified in the Collision Energy tab.

Auto MS/MS (Q-TOF only)

In Auto MS/MS mode, two additional tabs appear: Precursor
Selection I and Precursor Selection II.

The Spectral Parameters tab contains the same parameters as in
Targeted MS/MS mode. The other four tabs are used to enter the
boundary parameters for selecting precursor ions.

General | Source  Acquisition IREH.\assl Chromatogram

Speciral Parameters. | Collsion Energy  Precursor Gelection | IPrecursnr Selection Il | PreferrediExclude

Static Exclusion Range List

. [3 Max Pracursor Per Cycle
Mode: El 2 Static, Exchision Range Table
r ngg] Presursor Thisshold L =Gkl
#bs. Thisshold 200 Gt i et
At . . » so0] 1000
e Rel. Thieshold (%] [O.01 %
[Seg)
Active Exclusion
Taigeted
M55 [~ Ensbled
[Seg)

Evcludedafter [3 Spectra
Released after [73 min

Figure 39  Auto MS/MS mode with Precursor Selection 1 tab selected
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The software sorts a list of possible precursor ions whose order
depends on the boundary parameters entered:

a Passes all ions through (TOF only) and sorts the list from
highest abundance to lowest (or by charge then
abundance)

b Excludes those masses in the specified mass range
Sorts the list based on the priority of charges

d Moves preferred ions to the top of list in the order
specified

e Chooses the top ions on the list based on the entry for
maximum number of precursor ions per cycle (Max
Precursor per cycle)

f Excludes masses after a specified number of spectra have
been acquired and releases the exclusion after a specified
time (Active Exclusion)
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Varying scan speed based on precursor abundance

You can adjust the number of transients as a function of the
precursor intensity. Varying the scan speed is very useful when
you have a complex sample, such as a protein digest. To use this
feature, you mark the Scan speed varied based on precursor
abundance check box on the Precursor Selection II tab.

When this feature is turned on, the MS/MS acquisition rate is
automatically adjusted based on precursor intensity, thus
spending less time on the more abundant peptides and more
time on the less abundant peptides. This should improve MS/MS
quality and hence database matching.

The variable MS/MS acquisition mode can result in one or more
additional precursors being examined per scan cycle as less
time is spent on more abundant precursors.

See the online Help for information on Abundance Dependent
Accumulation and Purity.

General| Source  Acauisiion | Ref ass | Chromatogram |

E.pemralpammeters} Colision Energyl Precursor Selection | Precursor Selection |1 ‘Prefarredﬁxclude

Precursor Charge-State Selection and Preference Abundance Dependent Accumulation
Mode:
s Inactive Active [~ Soan speed varied based on precursor abundance

[
5e
Fed) 23 g ] Up Target [25000 courts/spectum
At Unk
& MSMS « 3 K

(Seg) onn

Reset [
Taigeted

£ MEME
Pt [——
(Seg) - Sort Precursors by Chargs State then P i

Abundance Fuity Stringency: [100 %
" Soit Precursors by Abundance only Puity Cutofl.  [30 %

Figure 40  Auto MS/MS mode with Precursor Selection Il selected
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Setup of TOF and Q-TOF reference mass correction

(recalibration)
You must do mass corrections Many applications need as small a deviation of accurate mass as
during a run in order to attain the possible. To obtain this accuracy, you recalibrate the mass axis
mass accuracy that Agilent for every spectrum with measurements of known reference
specifies for the TOF and O-TOF. masses (i.e “lock masses”). You measure the masses of reference

compounds in a reference standard, which can be the Agilent
reference standard or one of your own choosing.

You can introduce the reference standard into the TOF system
in one of three ways:

¢ A calibrant delivery system (CDS) that automatically
introduces the standard to a reference sprayer (second
sprayer)— Dual ESI (0.2 to 1.5 mL/min flow rates only), Dual
AJS ESI and Dual nano ESI

¢ An external dispense pump—other ion sources

¢ Addition to the sample—other ion sources

You can also use known ions in your sample, such as the “y1” in
a tryptic digest, as a supporting reference mass.
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Enabling reference mass correction

You set up and enable reference mass correction in the Ref Mass
tab within the TOF tab or the Q-TOF tab of the Method Editor
window.

General | Source | Acquistion  Ref Mass | crromatogram

Pefsrerce Mass Cormaction

T B Ficference Masses
Fielerence Masses Table

Mz
121.080873

143.02332
322048121
922.009758
1221590837
1521571475
242191389

o
5

¥ Use botile & Aol Now_ |

Ref Nebulizer |0 psig

R IR

£uto Recalibration Reference Mass Parameters

Detection Window 100 ppm

Minimum Height 1000 counts

Figure 41 Reference Masses tab

If you mark the Enable check box, the system uses reference
masses of the mass reference standard for automatic
recalibration of each acquired spectrum.

You must select the reference masses for each polarity in the
method. Reference masses are not only ion source dependent,
but also polarity dependent. To adjust both the a and TO terms
requires at least two reference masses, spread across the
application mass range, such that the first reference mass is
<330 m/z and the second is 500 m/z or more above the first.
Using more reference masses improves recalibration results. Up
to 20 masses can be selected.

The reference masses specified for the method will be stored
with the method. These reference masses are also stored in the
file with acquired data as TOF or Q-TOF method parameters.

If you mark the Use Bottle A check box, the TOF or Q-TOF
controls the valve to introduce the internal reference standard
to the reference sprayer via the CDS.

The Ref Nebulizer parameter is only available if the source is
either Dual ESI, Dual AJS ESI or Dual nanoESI.
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To learn more about the underlying
calibration equation and
coefficients, see “TOF mass
calibration” on page 51.

To know more about Segments and
Experiments, see “Automatic TOF
and Q-TOF parameter changes
during a run” on page 73.

Number of required reference masses

With two unknowns, a minimum of two known values are
required to determine both A and t,. Practical considerations
also come into play. In order to get a good fit for both A and t,
then at least one reference mass needs to be at a low mass value
and there needs to be at least one reference mass at a higher
mass. Standard analytical practice also suggests that the low
m/z and high m/z reference masses bracket the masses of
interest.

Specifically, the reference mass correction algorithm requires
that one mass be at or below 330 m/z with a second mass that is
at least 500 m/z above the low mass ion in order to correct t,
and A terms. If these conditions are not satisfied but at least
one reference mass is found, then only the A term will be
re-calibrated.

Selecting/editing list of reference masses

When creating a new method, the Agilent MassHunter
Workstation Software provides separate lists of reference
masses for each polarity. You can use the already provided mass
list, or you can create or edit a new mass list by right-clicking
the arrow to the left of each row in the Ref Mass tab.

Parameters for a reference mass correction

Scans To Average To increase the accuracy of the reference
mass correction, you can use a running average of the reference
mass values across several spectra. These mass values are used
in determining the corrected calibration coefficients. The
default number of spectra used is five. Only odd values are
allowed.

The software averages only spectra from the same scan group,
and therefore a spectral average spans a spectral cycle.

A spectral cycle contains one spectrum for each of the
Experiments defined in a given Segment.
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For example, if a Time Segment contains one Experiment with
Fragmentor voltage at 225 V and another Experiment with
Fragmentor voltage at 200 V, then a spectral cycle contains two
successive spectra, one at 225 V and another at 200 V.

Spectra from scans of different fragmentor voltage (or other
scan specific parameters) should not be summed and averaged
because they yield different masses.

Example The “Scans To Average” is 5. If the spectrum of interest is in the
nth cycle, then spectral data of the same Fragmentor voltage
from cycles n-2, n-1, n, n+1, n+2 are used in the average with
equal weights. If this Time Segment has defined one Fragmentor
voltage of 225 Experiment #1, and one Fragmentor voltage of
220 Experiment #2, and the current spectrum is the
Fragmentor voltage of 225 Experiment #1 of the nth cycle, the
spectra n-4, n-2, n, n+2, n+4 will be used for the average.

Reference Mass Window When the software attempts to find
the reference mass, it searches for the highest spectral peak in
the defined reference mass window, which is the window width
in parts per million (ppm). Recalibration using reference
masses of the internal reference standard does not replace
normal or external mass calibration. You must set the window
for recalibration small enough so the software does not pick

a spectral peak from the sample as the reference mass peak. 100
ppm is the recommended default value.

Reference Mass Minimum Height The “Reference Mass
Minimum Height” is the abundance in counts. The software uses
this height to exclude noise peaks and peaks of reference
masses that may fall within the detection window but that are
too small to be used for calibration. This is especially important
if you use reference masses that may be present in the tryptic
digest, such as the y1 ion (147 m/z for N-terminal Lys or 175 m/z
for N-terminal Arg), but may not be present in all spectra in the
run. Signals below 1,000 counts are generally too low to be used.
Signals above 75,000 counts for the reference mass ion can
negatively affect the reference mass correction.
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TOF and Q-TOF chromatogram setup

In the Chromatogram tab, you also select the chromatograms or
the set points/actuals that you want to see in the
Chromatogram Plot window during the run.

General | Source | Acquistion | RefMass Chiomatogiam
Chromatograms
Chramatogran Label Estracted Expt Type PT“'J,‘;"e‘y Offset | Y-Range

rp|EIC | |z70315 WE ~|Bath | 18] 1oooooao|
TIC [nc | ms [Batn | 15| 10o0ooaa

Figure 42 Chromatogram tab in the TOF or Q-TOF tab

You can select the signal to plot (TIC, EIC, BPC, Set point,
Actual), the experiment type, the offset of the baseline for the
plot and the valid range of values in counts. You can also set the
mass range for the EIC.
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Setting parameters to acquire a data file in All lons MS/MS
mode

In order to acquire a data file in All Ions MS/MS mode, it is
necessary to set up a method that has a Time Segment with at
least two and a maximum of four different Experiments
containing different Collision Energy values on a Q-TOF or
different Fragmentor voltages on a TOF.

The low energy Experiment provides MS information, and the
high energy Experiments provide MS/MS fragment information.
See the Qualitative Analysis Familiarization Guide for LC/MS
for more information on analyzing a data file that was acquired
in All Ions mode.

If you have a Q-TOF instrument, you set the Collision Energy to
0 in the first Experiment. In the subsequent Experiments
(channels), you set the Collision Energy to a higher value (for
example, 20 V). If you are creating a method for a Q-TOF with
different collision energies, you set the Fragmentor voltage at
the same value in each experiment. It should be set to a low
enough setting that no fragments are generated in the source
but at a high enough setting that you get enough precursor ions
transmitted to the skimmer. This value depends on the
compounds you are analyzing and their stability. You set the
Collision Energy and the Fragmentor voltage on the Source

tab.
Froparies DA HiPSampler  HiP Samgler Preveatment  Binary Pump  Colemn Comp. | O-TOF
tom Source lom Piotarity - - Diata Stosage, L Sheam . Genaral | Sowoe || Acquistion | Ret Mass | Crvomatogran
DuslE5I =] | [Festive fon M§ DudES| (Seg) M5 TOF Expe)
Stogs T i S ogrroond s puimend & feTonp 200 |RC 00 e s T
Sl v
= HoLinkihs Pus Time fmin] Ewpt 5
0 » Dy Gt [11 Uiy M Uen OCTARFYpe [F0 v
Sl 37 0 || gy 2 Mabuies [T pio -
Cokton: Ermegy [0 v
Dual E51 [Ewpd]
VCao | 3600 v Capllay (7670 1
Cycle Time ﬁ 5 ]
Chasber 101 L

Figure 43  First Experiment has a Collision Energy of 0 V
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Figure 44  Second Experiment has a Collision Energy of 20 V

Since All Ions MS/MS is not an isolation MS/MS experiment,
you set the Mode to MS (Seg) on the Acquisition tab. For the
acquisition rate, you should attempt to get 8 to 10 data points
across the chromatographic peak for each collision energy
channel. For a typical peak width of 10 seconds at the base, the
recommended Rate for a 2-channel experiment (for example, 0
and 20 V) is 2 Hz; for a 3-channel experiment (for example, 0, 20
and 40 V) the recommended Rate is 3 Hz, and for a 4-channel
experiment (e.g. 0, 10, 20, 40 V), the Rate is 4 Hz.

It is highly recommended to use Collision Energy values of 10,
20 and 40 volts for the three high energy experiments because
those energies match the Collision Energy values that have
been used to acquire the accurate mass MS/MS spectra in all of
the MassHunter Personal Compound Databases and Libraries
(PCDLs) that can be used by the All Ions MS/MS algorithm in
the Qualitative Analysis program to select fragment ions.

On a TOF instrument, good starting values for the voltages for
pesticides are shown in Table 9.

Table 9  Fragmentor voltages for All lons MS/MS Experiments

Number of Experiments Expt1 Expt 2 Expt 3 Expt 4
2-channel 110V 275V

3-channel 110V 180 V 300V

4-channel 110V 175V 250V 325V
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Setting up an experiment with two or three high energy
experiments allows the analysis of a large number of target
compounds that span a wide variety of compound stability.
While this allows selecting fragment ions with higher signal
from an optimized collision energy, it also decreases the time
that is spent on the precursor ion in the low energy channel,
thereby decreasing its signal. In a 2-channel, 3-channel and
4-channel experiment, the amount of time spent on the
collection of the precursor ion intensity is 50%, 33%, and 25%.
However, if a qualification of quantitative results on the
precursor ion in the low energy channel via fragment ion(s) in
the high energy channel is required, then the higher of the lower
limit of quantitation (LLOQ) for the precursor ion and the lower
limit of detection (LLOD) for the fragment ions will be the
actual LLOQ, and it may make sense to conduct a multi
high-channel experiment.

When you are setting up the experiments, you have the first
experiment have the low energy value, and then you increase
the Collision Energy or Fragmentor voltage for each successive
experiment. So, the highest Collision Energy or Fragmentor
voltage is in the last experiment.
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Method saving, editing and reporting

Saving a method with data acquisition parameters

To learn how to set up scripts, see
your Agilent application engineer.

For more information on scripts,
see the online Help.

Adding Pre or Post Run Scripts before saving

Before you save a method, you can enter the pathway for the
customized scripts that start before or after a run. You do this
on the Properties tab.

Method Editor

@ |2 [ B 5 |[Defautt With Dualals EsLm <)/ Apply | @ Reset
Properties]| DA HiP Sampler  HiP Sampler Pretrestment  Binary Pump  Column Comp. DAD  Q-TOF

Wethod

Path Est. Run Time
D:\MassHurtter\Methods*Default_With_DualAJS_ESIm )

Pre Run Script

Past Run Seript

Description
Default Method

Figure 45 Properties tab of the Method Editor window

Scripts can be written using any programming language. Scripts
provided by Agilent should not be modified since these files
may be overwritten when upgrading the Agilent software.

Below is a list of scripts that Agilent includes with the software
and that you can use with both methods and worklists.
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Table 10  System scripts and the actions they enable

Script name Actions the script enable

SCP_AcquireCalibrantData Sets “Cal/Ref Mass” to “Cal B” and
“LCStream” to “LC->Waste". Allows you to
acquire data for the calibrant solution itself.
To be used only as the Pre-run script for
a method. The script itself does not do a run
and only augments an existing method. Do
not use as a standalone script in a worklist
run.

SCP_MSDivertValveToMS Sets the solvent divert valve to the “MS”
position.

SCP_MSDivertValveToWaste  Sets the solvent divert valve to the “Waste”
position.

SCP_InstrumentStandby Puts the instrument in standby mode. This is
the same as clicking the “Standby” button on
the Instrument Status window.

SCP_LoadldleMethod Loads a method to put the system in an idle

(MethodName) state. The first parameter is the method
name.

SCP_MSRefOff Turns off the MS reference ion solution (Ref
A)

SCP_PumpsAllandMSRefOff ~ Turns off LC pumps and turns off the MS
reference ion solution.

SCP_PumpsAllOff Turns off all pumps.
SCP_LCCondition Starts a run for conditioning the LC part of
(MethodName, LCStream) the instrument. No data acquisition happens.

SCP_CalibrateTOFMassAxis Starts a TOF/Q-TOF mass axis calibration in
the active polarity using the default mass list

SCP_TraceOnOff Switches the trace to ON or OFF. The first
parameter must be either “on” or “off”.

SCP_ClearTrace Clears the trace file.
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Table 10  System scripts and the actions they enable

Script name Actions the script enable

SCP_ProcessQuantReport Runs a single sample Quant report.
Quantitative Analysis must be installed. Use
only as a Post Method script.

SCP_CTCReset Resets the CTC autosampler. If a drawer is
open, it will be closed.

Location of method folders

You can save methods to any folder on the system. The default
folder is D:\MassHunter\Methods\.

You can view the name and path of the currently loaded method
in the Properties tab of the Method Editor window (Figure 45).

Method editing

You can edit methods containing data acquisition parameters
using the Method Editor window of the Data Acquisition
software.

Use this location for method development. The set points are
sent to the instrument when the method is loaded and when
you click the Apply button after changing a parameter.

Methods can also contain Qualitative Analysis and Quantitative
Analysis parameters. You can modify the Qualitative Analysis
and Quantitative Analysis parts of the method in the DA tab in
the Method Editor window. See the Agilent MassHunter
Workstation Software Qualitative Analysis Familiarization
Guide or the online Help for the Qualitative Analysis program
for more information on the Qualitative Analysis software. See
the Agilent MassHunter Workstation Software Quantitative
Analysis Familiarization Guide or the online Help for the
Quantitative Analysis program for more information on the
Quantitative Analysis software.
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Method reporting

You can see the parameters in a method in one of three ways:
¢ You click Acquisition Method from the File > Print menu.
¢ You review the parameters in the Method Editor.

You can see method parameters associated with a data file in

the Agilent MassHunter Workstation Qualitative Analysis
software.

Acquisition Method reports include this information:
¢ Method name, path and description
¢ List of configured LC modules and TOF or Q-TOF

¢ Parameter values for each LC module and for the TOF or the
Q-TOF
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Worklist setup 102
Data acquisition for samples and worklists 118

Learn the concepts to help you understand the setup of single
samples for interactive data acquisition and the setup of single
samples and sequences of samples for automatic data
acquisition.
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Interactive single sample setup

If you want to run just one sample at a time, you enter the
information for that sample in the Sample Run window.

Sample information

The sample information that the system records with the data
file is the sample name, vial position and other information in

the Sample Run window, such as Sample Type and Injection
Volume.

Sample information is not part of the method. It is stored with
the data file when the method currently loaded is run.

Injection Volume
You can specify an injection volume for the sample in this box.

You select the value As Method if you want to use the injection
volume specified in the method.

Sargie(016d | View Data

C\MassHurter' Data

Figure 46  Sample Run window

Data File information

The default folder for TOF/Q-TOF data is D:\MassHunter\Data.
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Auto Increment If you want to use the same file name and have
the system automatically change the number at the end of the
file name, you turn auto-increment on. Then, you type a file
name that ends in the number 001, and the system makes sure
that a new file is created every time you re-run that sample.

Other folders

You can save your data to any folder on the system. You must
use the browse button to select a different folder. To open any
data file saved to a different folder than D:\MassHunter\Data,
you must browse to the different folder.

Some of the Additional Information parameters

Sample Type

You specify one of the following types for a single sample run:
Sample, Calibration, QC, Blank, DoubleBlank, Matrix,
MatrixDup, MatrixBlank, ConCal, TuneCheck, and
ResponseCheck.

Method Type
Acquisition Only, DA Only, or Both Acquisition and DA.

Run Types

This value is not shown by default. You can add it by clicking the
+ button and adding it using the Add Parameters dialog box.

Standard Start for LC runs

Manual Run for infusion runs with a syringe pump
External Start for AP-MALDI

LC Only Run for when you do not acquire MS data
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Worklist setup

Agilent developed worklists for the primary purpose of running
many samples automatically and then reporting on the
compounds found in the samples.

The worklist lets you enter sequences of samples—both single
and multiple samples—to be run automatically in the order of
their listing.

The worklist operates as a spreadsheet much like Excel. You can
copy, paste, and fill in columns as you would in Excel.

: Workdist X
OYde » [ |[sulfaWorklist wki -
¥ Sample Name Sample Position Method Data File Sample Type Level Name Comment Sample Group Info 2|
1w [Sulfal P1-A1 AJSES|_defaultm |sutfas001.d Sample
2 v | Sulfal F1-42 AJSES|_defaultm sulfas002.d Sample
3w Sulfal P1-A3 AJSES|_defaultm sulfas003.d Sample [~
| o[

‘Worklist

Worklist | Method Editor | Sample Run |

Figure 47  Example worklist

Selected Each line in the worklist table has a check box that allows you
sample to mark that line for processing or not. This can be useful if you
execution need to restart a worklist after some lines have already been
run.
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Worklist menus

You find all the tasks to create a worklist in the worklist menus.

¢ Add a single sample one at a time or add multiple single
samples all at once

¢ Add scripts before or after the worklist or between samples
in a worklist

¢ Add or show more sample information columns

¢ Add, insert or delete rows and columns

¢ Set up to print a worklist report or track a worklist run

Each menu has different commands available. Some commands
are only available in certain situations. For example, in the
column shortcut menu, you can only use the Insert Column (s)
command if you select a column that has been added using the
Add Column(s) menu.

Right-click upper left- Right-click column Select row and
hand corner of worklistto  Click Worklist to view Right-click cellto  header to view right-click row to
view worklist menu. top worklist menu. view cell menu. column menu. view row menu.

— wm/an/m o e

Sample  Workfist Methed Tools Help
Jm- a )

: [Acquisition - | LS [Pattyiyt

x
Hew ]
Qpen_. CeA-W =
Save cme, 0d Data File Sample Type Level Name Commgnt Sample Group
Save . |sulfal d [Sample [ [
el - - | Add Multiple Sampl
. - Multiple Samples...
Worklist ‘Add Column(s).. I Pl
Add Sample — ample
2 Cut
Add Script... Add Mulgls Samples. Add Script...
Add Sampie Copy -
Copy Row(s) Add Serh Insert Multiple Samples...
Insert Sampl
Ingast Sample Edit Samples... Show/Hide/Order Columns... gl il
Insent Sergh.. Insert Script...
Delete Row(s) Delete Cut
View Data... C Delete Row(s)
Add Colymn(s)... Lopy
Eill » Cony Rowls)
Show/Hide/Order Columns... Copy Row(s,
Text Size . Edit Samples...
i 3
Add Workist... iy Colur Bl
ShorwHides Order Columng._.
Worklist Run Parameters... Wiod
. e Add Replicates...
Import Worklist... w
Add Worklist..
Wrap :
- Insert Worklist...
+ Track Worklist Run

Import Worklist..

Figure 48  Worklist menus
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Sample entry

One-at-a-time entry

You may want to do this to equilibrate the system before
running a worklist.

Multiple sample entry

If you want to add several single samples to the worklist at one
time, you use the menu selection to add multiple samples. You
can add different samples or one sample injected several times.

Sample When you add multiple samples, you can specify the data folder,
Information method names and injection volume.

Add Multiple Samples
Sample Information | Sample Pesition
Sample
Name: Sample [¥] Append Counter
Suffx Counter
Number of digits: 1 Start Value: 3 Step: 1
Data File
Name: WiorklistData [¥] Append Counter
Suffix Counter
Number of digts: 1 Start Value: 3 Step: 1
Path: D:\MassHunter'data =)
Method
Mame: | ACQ_AutoCEFixed m [=]
Path:  D-\MassHurter\methods =]
Override DA Method
Name: | <None>
Path:  D:\MassHunter\methods =]
Injection
Injection Valume: | As Method [=] W

Figure 49  Add Multiple Samples dialog box
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Sample You can select the sample positions without having to type in
Position their values from the Sample Position tab on the Add Multiple
Samples dialog box.

Add Multiple Samples [

Sample Infermation | Sample Position

Cumertt Configuration

Sslect Wellplste or Vial Tray Plate/Tray Typs
Select Tray
- Well-plate Tray
F: g Selection Origin Block Increment
P2: TestPlats @ Toplek @ Top right @ Row major

10 2ml vials ) Column major

© Botiomleft ©) Botiomright ) Sementine

Number of samples Number of replicates
0 1

Well-plate/ Tray

1 2 3 4 5 3 7 8 9

Figure 50  Sample Position tab of the Add Multiple Samples dialog box

Sample methods

You can create a .m method containing either acquisition
parameters, data analysis parameters or both. See the Quick
Start Guide or the online Help for instructions for creating the
method.

If you specify a method with both acquisition and data analysis
parameters in the worklist, you select which parts to run in the
Worklist Run Parameters dialog box for a worklist and in the
Sample Run window for a single sample run.
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Script entry

Scripts are special programs, that ~ You can enter scripts to be run at the following times:
execute automatically. Agilent
includes scripts with the Agilent
MassHunter Workstation
Software, and you can write your
own scripts. ¢ Before or after samples in the worklist or batch (insert or

add scripts, respectively)

* Before or after samples as part of the method

The sample method can include pre- and post-analysis
scripts. (See Chapter 3, Acquisition Methods)

* Before or after a worklist and after data acquisition
(Figure 55 on page 113)

Scripts provided by Agilent should not be modified since these
files may be overwritten when upgrading the Agilent software.

For detailed instructions on how to enter scripts, see the online
Help. For instructions on how to create scripts, see your Agilent
application engineer.

Agilent includes scripts with the software to help you
automatically, instead of manually, execute processes such as
column conditioning and valve shutoff. See Table 10 on page 95
for a list of possible scripts.
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Entry of additional sample information (show, add columns)

The default worklist contains only nine columns for sample

information.
! Worklist x
Ordd » B -]
W | Sample Mame = Sample Position Method Data File Sample Type | Level Name | Comment | Sample Group Info.
1 [ ] | | [Sample | | | \ \
Worklist

Figure 51  Default worklist columns

You can access these capabilities You can add more columns in one of two ways:

through the worklist menu. ¢ Show or hide columns that contain sample information

already available in the worklist

¢ Add columns for new sample information

Show/Hide/Order sample information

Note that hiding a column does not ~ With this dialog box you can hide any of the original default

delete the column. To delete the columns and show others. You can also change the order of the
column, you must first show the columns. The marked columns are shown in the worklist in the
column in the worklist or batch. order they appear in this dialog box.

Show/Hide/Order Columns

S ample (D -
| Sample Name
Rack Code
Rack Position
Plate Code
Plate Position
w| Sample Position
| Method
Oweride DA Method
| Data Fils
w| Sample Type
| Leval Name
Method Type:
Balance Overids
Inj %ol )
Equilis Tims (min)
Dilution
wWivol
iw| Comment
Baicode -

Show Al up

Hide Al | Dawn | Default |

Figure 52  Show/Hide/Order Columns dialog box

n
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Add sample information columns

When you add columns, you can enter sample information and
values for compounds, masses and acquisition parameters. You
can also enter your own sample information, including
empirical formulas. You can add a column for the Molecular
Formula which can be used in the Qualitative Analysis program.
The Column Type MFC is only available if the Qualitative
Analysis program is installed on the same computer. The
Column Type Protein is only available if the MassHunter
BioConfirm program is installed.

When you add a column, it appears
in the Show/Hide/Order Column ""; .c“: I
dialog bOX. olumn Type olumn Information

M5 parameter value that overrides method

User Dafined
MFC

Available columns: Selected columns;
2|

Protgin

CE Mods
CE Offset

CE Dffsets uta
CE Slope

CE Slops
Corona-

Cancl
Figure 53  Add Columns dialog box

Worklist import

You can populate a worklist with sample information from other
files in multiple ways:

¢ Use the Study Manager program which automatically creates
a worklist when you submit a study.

¢ Copy individual columns one at a time from an Excel
spreadsheet (or a csv file imported into Excel) and paste (or
fill) them into the TOF or Q-TOF worklist under the correct
header

You do this when you need to transfer information
infrequently or the information is different for each transfer.

¢ Import a csv file directly

You cannot import a partial list of You do this when you need to use the same parameters in a
the samples within the csv file. worklist frequently.
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You can import the csv file to add or
insert samples whether the
worklist is running or not. You can
also import the file in an offline
session.

You cannot import scripts into a
worklist. You must add them
directly.

Data Acquisition 4

CSYV file mapping

You use the Map File Generator program to modify a map file.
You start this program by clicking the Map File Generator icon
in the Agilent MassHunter Workstation > Acq Tools folder.
See the online Help for more information on this program.

Your sample csv file contains a table of samples and attribute
information for each sample. The information in this file may
not correspond to the information needed in a TOF or Q-TOF
worklist in several ways.

¢ Some of the information may not be relevant.
* Some information may be missing.

¢ Column names of the sample attributes may not be the same
as those used by the Agilent MassHunter Workstation Data
Acquisition software.

You must first edit the sample csv file to put it into a form that
maps to TOF or Q-TOF sample data. You can specify these
changes when you map to the TOF or Q-TOF data:

¢ Change the column header names
¢ Add new columns in the worklist

¢ Change data values

You can include a mapping section in front of the sample
information in the sample csv file or in a separate configuration
csv file. You use a configuration csv file when all the sample
information values are the same from import to import. You
also include the mapping section in the sample csv file when
new groups of samples with different dynamic mapping of
columns, such as amount of compounds analyzed, are added for
import.

Mapping for static worklist columns

Some worklist boxes are static and invariant, such as Sample
Name and Sample Position. These come under the heading,
Static Mapping, in the mapping section of the csv file.
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Mapping for dynamic worklist columns

Some columns in a worklist are dynamic and change from
analysis to analysis. The mapping capability in the csv file lets
you specify additional columns to be added to the worklist. The
name of the added worklist column should use the same name
as the csv column specified. You then specify the column type in
the worklist, such as Compound, Mass, MS Parameter, User
Defined or Custom Parameter. These new columns to be added
to the worklist come under the heading, Dynamic Mapping, in
the mapping section of the csv file.

Data Value mapping Data values for some columns, such as
sample type, are limited to a drop-down list in the worklist and
do not match the same names as are in the csv file. Data value
mapping is preceded by the key words [Data Value Mapping]

Example mapping section

You want to import samples into a TOF or Q-TOF worklist, but
the column headers in the CSV import file (Excel spreadsheet)
are different from the worklist column headers. For example,
“Sample” is used instead of “Sample Name”, as shown below:

Table 11  Original sample table

Sample Acq MyData DA SampPos Sample Type Internal
Method StdA

AAA method1 qwwq method1 1 Standard 1

BBB method2 bbb methodl 2 Sample 1

ccc method3 ccc methodl 3 QualControl 1

One column header, “InternalStdA”, must be added as a new
column to the worklist. You can also add columns that do not
exist in the csv file, such as “Caffeine” in the section below.
Some data values are also different (e.g., Sample Type values).

Table 12 is the mapping section for the spreadsheet in Table 11.
This is the spreadsheet version of the mapping that lets the
worklist import program recognize columns of imported data.
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Table 12 Mapping section for csv file

[Static Mapping]

Acq Method Acquisition Method
MyData DataFile Name

DA DataAnalysis Method
SampPos Sample Position
Sample Sample Name

[Dynamic Mapping]

(//Added column)

InternalStdA Compound 1
Caffeine Compound

[Data Value Mapping]

Sample Unknown

QualControl ac
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Report setup

After you run the worklist, you can send a worklist report to
one or more of these locations: Screen, Printer, Excel File or
PDF File. You specify the report destination and the file path in
the Worklist Report Options dialog box.

You can also specify to print all of the columns that are part of
the table or to print only the visible columns, and you can select
a different Worklist Report template. You can modify the
worklist report template if you know how to modify an RDL
report.

"Warklist Report Options ===

Report Columns

© Al @ Visible

Report Tempiate Selection
Report Template | WorklstReport =

Report Destination

@ Screen
(©) Printer Microsaft XPS Document Writer

©) Excel File C:\Users“\Admin‘\Documents\Worklist_Report xis

(©) PDF File C:\Users\Admin\Documents\Worklist_Report pdf

Figure 54  Worklist Report Options dialog box
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Before you run a worklist you select parameters for the entire
worklist.

Worklist Run Parameters

Start run types and the part of the method to run

Paths for the acquisition method, data analysis method and
data file

Whether or not to combine export output when also running
a Qualitative Analysis method

Scripts to run before or after the worklist
Free disk threshold

The free disk threshold is the amount of disk space in
gigabytes that must be available before the worklist starts.

Page 1 T Pags 2 ]

Operator Information

Operatorname: [

Runi Information

R Ty Standard Start | Ewecution for Synchronous <]

Acquisition-DA:

Part of method 1o [acquisiion Orly =] ¥ 5108 workist on DA error

un:

Method Paths

Methad |E\MassHunter\methads

Ovenide DA [CMassHunter\methads

Data File

Path: C:\MassHunter\data

Sciipts

™ Freworklst |

I~ Postworklist |

Acquisition
™ Cleanup ‘

S T

I Postanalysis |

Disk Information

Free Disk, 10 (Ghytes)  Available 5278 (Ghytes]

Thiashold: Diskspace:

Flun Settings

Wait Tmefor [ {min)
¥ Ovetlapped Injection i
¥ Clear sampls selsction after un

oK. Cancel

Figure 55  Worklist Run Parameters dialog box
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Overlapped Data Analysis with Acquisition

You can choose to start the next data acquisition run when the
data analysis is complete, or for higher throughput of samples,
while data analysis of the previous sample is still running.

This option is selected in the Worklist Run Parameters dialog

box, in the Execution for Acquisition-DA list box. To overlap

data analysis with acquisition, select Asynchronous. To cause
data acquisition to wait until data analysis is complete, select
Synchronous.

Overlapped Injection

You can load a sample into the sample loop during a run that is
still completing. This option allows you to save time that is
required to load the sample before the run.

To select this option, mark the Overlapped Injection check box
in the Worklist Run Parameters. You also have to select this
option in the individual methods being used in the worklist.

Estimate of worklist file size

Depending on your estimate of the file size of the worklist, you
may have to change the default value of the Free Disk
Threshold.

You can run a typical worklist sample to estimate the worklist
file size. Then, you observe the file size in Windows Explorer,
and multiply the observed file size by the number of samples in
the worklist.

The data file for profile data is compressed by a factor of 3 - 20,
depending on the complexity of the mass spectra acquired. This
new feature greatly reduces the data storage needed for profile
data.

The Instrument Mode selected for the Accurate-Mass TOF and
Accurate-Mass Q-TOF also affects the size of the data file. The
Agilent TOF and Q-TOF instruments now will acquire 2 times as
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much data when operated in the 2 GHz mode (extended
dynamic range or extended mass range) or 4 times as much data
when operated in the 4 GHz mode (high resolution).

Method parameters that control file size

LC data is usually a small fraction of TOF or Q-TOF data. The
size of the acquired data file depends on these TOF or Q-TOF
method parameters:

¢ Data file storage type—Profile, Centroid, Both or None

Profile stores raw data as abundance values for evenly spaced
ion flight time. Centroid stores only the assigned peaks but not
the raw data. Both stores both Profile data and Centroid
data. None stores no data but does store spectrum metadata
and method parameters.

If you want to analyze your data in Qualitative Analysis using
either the Large Molecular Feature Extractor (LMFE)
algorithm or the Deconvolute (MS): Maximum Entropy
algorithm, you acquire in either Profile or Both modes.
Profile data is required for both of these algorithms.

¢ Total run time
¢ Setting of time segments

¢ Number of experiments that are defined

Approximate file size for stored Profile data

The file size per spectrum depends on three variables.
e Mass range
¢ Spectrum metadata

¢ Compression factor - the data file is compressed by a factor
of 2 to 20, depending on the complexity of the mass spectra
acquired

Mass range You can reduce data file size by reducing the mass
range of interest. Profile data are stored as abundance for each
flight time. If you restrict the mass range, the number of data
points in the spectrum depends on the mass calibration curve.
The table below shows the number of possible data points for a
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Note that low masses require more
data points than high masses
because of the non-linear nature of
the time to mass conversion.

given mass range using a typical mass calibration curve. The
Agilent 6540 UHD Accurate-Mass Q-TOF has approximately 25%
more data points.

Table 13 Number of data points pre spectrum for given mass ranges

Mass range Number of data Number of data Number of data
(Daltons) points (1 GHz) points (2 GHz) points (4 GHz)
50 to 750 50,000 100,000 200,000

50 to 1000 60,000 120,000 240,000

50 to 3000 100,000 200,000 400,000

250 to 1000 30,000 60,000 120,000

500 to 3000 60,000 120,000 240,000

250 to 3000 70,000 140,000 280,000

Each data point stored requires 12 bytes of storage. A mass
range of 250 to 3000 requires 840,000 bytes per spectrum at 1
GHz acquisition rate. If the scans/sec. equal 1, then the data
storage required for one minute worth of spectra before
compression is 50,400,000 bytes or about 48 MB. Then, this data
is compressed which means the actual data storage needed is
between 2.4 MB and 16 MB (with a compression ratio between 3
and 20).

If the run time on a run with one time segment is 5 minutes,
then one run requires between 12 MB and 80 MB of disk space.
A worklist with 10 samples using the same mass range requires
between 120 and 800 MB of disk space. If the scan rate is set to
20 scans per second, the data file could require a large amount
of disk space.

Spectrum metadata In addition to data points, information on
the spectrum, such as the instrument actuals and set points,
used during acquisition is stored with each spectrum. This
information takes 2884 bytes per spectrum or about 8.2 MB for
the worklist described above.
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Storage of method parameters for each run also affects file size
but to a lesser degree than the file size of the spectrum. They
take up about 10,000 bytes before sample injection starts. For a
10-sample worklist, they take up less than 0.1 MB.

Approximate file size for Centroid data

Data is not stored as the abundance at evenly spaced ion flight
times. Rather, peak centroids are computed first. Each data
point is stored as a pair of values of mass and abundance. The
data storage required is 12 bytes per detected peak in the
spectrum. The number of peaks detected is dependent on the
number of compound peaks in the spectrum as well as the noise
in the background and the threshold set.

If the mass range is set as 250 to 3000 and the threshold is
appropriate, about 3000 to 5000 peaks are detected in one
spectrum. If the scans/sec. is 1, the run time 5 minutes, and ten
samples are in the worklist, then the disk space needed for
these samples is between 102 and 172.5 MB.

If you have a 2 GHz instrument, the disk space needed for these
samples is between 204 and 345 MB. If you have a 4 GHz
instrument, the disk space needed for these sample is between
408 and 690 MB.

Spectrum metadata and method parameters are also stored
with centroid data and comprise a greater percent of the file
size than with Profile data.
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Data acquisition for samples and worklists

What you can monitor during a run

For more information on real-time
plots, see “Real-time displays” on
page 63.

Tracking sample runs

The worklist shortcut menus contain an option called “Track
Worklist Run” that you can turn off or on. The default position
is on. With Track Worklist Run on, you can see what sample is
running at any time during the worklist run.

When you start a worklist run, the first sample row turns dark
blue, indicating that the sample in this row is running and data
is being acquired. When the data acquisition finishes, the first
sample row turns light blue to indicate that Data Analysis is
running.

If you have set Execution for Acquisition-DA to Asynchronous,
you will see both a dark blue and a light blue line to indicate
which lines are acquiring data and analyzing data.

Monitoring the Chromatogram Plot and Spectrum Plot windows

You can also monitor the TIC or EIC chromatograms, L.C
parameters and mass spectra for each sample during the
worklist run. You can print a plot of the real-time data by
clicking the File > Print > Real-time Plot Report command.
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What you can do during a run

Locked Mode

You can turn Locked Mode on or off using the toolbar icons in
the main toolbar. If Locked Mode is turned on, you cannot edit a
worklist or method while the data is being acquired. Also, the
data file is protected, so you cannot overwrite the data file if
you run this method or worklist again. If Locked Mode is turned
off, then you can edit the worklist during a run.

Editing current worklist during run

You can edit any sample row or batch row during a run as long
as the sample is located below or in the second row after the
running sample row. If the last selected row is executing, then
all rows are locked.

When you switch to a row to edit the sample, the “Track
Worklist Run” option automatically turns off. To see the sample
row running after your edit, you select this tracking option
again. The screen then automatically switches to that part of the
worklist with the sample that is running.
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What you can do during a run
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